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WELCOME 
Thank you for selecting EZ-CAM as your CNC programming solution. We're confident 
you will enjoy many years of productive service from our products. The EZ-CAM prod-
uct family has been designed to give you the best combination of simplicity and flexibil-
ity, so you can program your parts in the shortest possible time. Please use this booklet to 
familiarize yourself with the basic steps involved in programming a part with EZ-MILL 
and EZ-TURN, and the many features and capabilities available to you. 
 
 

OVERVIEW 
The first chapter of this manual is intended to give you important information about 
hardware requirements, installation and user interface. Chapters 2 to 5 include four com-
plete tutorials, which give you detailed step-by-step instructions describing the entire 
process of creating NC (Numerical Control) programs. The last chapter contains a brief 
overview of our EZ-DNC communications utility. 
 
 
Below you will find a short description of the chapters enclosed: 
 
 

CHAPTER 1:  Introduction and Setup 
Hardware Requirements, Installation, User Interface. 

 
 
CHAPTER 2:  EZ-MILL 2D Tutorial 

Advanced 2D Part to explain general Handling, Geometry 
Creation and 2D Machining. 

 
 

CHAPTER 3:  EZ-MILL Pro / 3D Cavity Machining Tutorial 
Advanced 3D Part to explain Data Import and 3D Surface 
Machining. 

 
 

CHAPTER 4:  EZ-TURN Tutorial 
Standard 2D Turning. 

CHAPTER 1.  
INTRODUCTION AND SETUP  
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CHAPTER 5:  EZ-TURN & MILLING Tutorial 

Turning  & Live-Tool Machining. 
 
 
CHAPTER 6:  EZ-DNC (Communication) 

Communication with the Machine (via RS232). 
 
 
 

Throughout the manual you will find important notes  , tips   or references to the 
online help where additional information on the commands and functions is provided. 
 
 

EZ-CAM INSTALLATION 
View the subsequent paragraphs for more information about system requirements, instal-
lation instructions and the software protection key. 
 

   
Before adding new modules or installing any software updates, it 
is strongly recommended to backup all EZCAM related INI files 
that are located in the operating systems main directory (normal-
ly “C:\WINDOWS”). Although existing INI files are not over-
written during the setup process, newly installed EZCAM appli-
cations may modify the files so they cannot be used with previ-
ous versions in case the system needs to be restored. 
 

EZCAM.INI 
All EZCAM Applications 
(Default Settings, last used Files/Folders) 

EZ-CAM19.INI 
EZ-Mill & EZ-Turn 
(Screen & Toolbar Layout) 

EZ-CAMX19.INI 
EZ-Mill & EZ-Turn Express 
(Screen & Toolbar Layout) 

EDM19.INI EZ-EDM 
(Screen & Toolbar Layout) 
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SYSTEM REQUIREMENTS 
Before you begin the setup process, please confirm that your system meets the following 
minimum requirements: 
 

Component Minimum Requirements 

Operating System * 
Microsoft  Windows XP Home/Professional 

Microsoft  Windows Vista Home/Professional 

Microsoft  Windows 7 Home/Professional 

Processor 2.8GHz Pentium 4 / 2.0GHz Core 2 / AMD 2400+ or faster 

Memory 2 GB recommended ** 

Hard Disk Space 420 MB, depending on type of installation 

Display 

256-color Graphic Adapter, Open-GL support 
Color Monitor capable of 1024x768 pixel resolution  
(1280x1024 recommended) 
 
For 3D solid simulation & surface shading: 
True Color, 1 GB RAM, Open-GL support 

* Both 32 and 64 bit systems are supported 
** Check operating system requirements 
 
 

INSTALLATION FROM CD 
 

Remove the USB software protection key from the computer  
before starting the setup 

 

1. Close all applications and insert the EZCAM setup CD. 
 

If “Autorun” is enabled on your system, the installation starts automatically 
and brings you to the “Welcome” dialog. Select the “Install EZCAM” op-
tion and continue with Step 4 below. 

 

2. Select the “Run” command from the “Start” menu. 
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3. Type “D:\setup” (substitute the appropriate letter of your CD-ROM drive 

for D) and select “OK” to start the installation routine. 
 

4. Once you agreed to the “License Agreement” you’ll come to the dialog that 
defines the destination folder (default “EZCAMW”). Continue pressing 
“Next”. 

 
5. The next dialog gives the choice of “Typical” or “Custom” setup type. 

Choose “Typical” for complete installation or “Custom” if you would like 
to customize the selection of EZCAM modules that are installed. Continue 
pressing “Next”. 
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6. If  “Custom” was selected, the dialog shown below is used to select the de-

sired modules. Continue with pressing “Next”. 
 

 
 
 

   
EZ-Mill / Mill Pro and EZ-Turn users are also licensed to install 
and use the Express versions of their products 
 (Mill/Mill Pro  Mill-Express, Turn  Turn-Express). 

 
 
7. Follow the instructions on the screen to complete the installation. Setup 

then installs all necessary files onto your hard disk and creates the EZCAM 
program group. In addition an icon for every installed module is created on 
the desktop. 
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THE SOFTWARE PROTECTION KEY 
Every EZCAM package is shipped with a software protection device from SafeNet (also 
referred to as Dongle) which can be plugged to any of the USB ports. The SafeNet sys-
tem driver is automatically installed by the EZCAM setup so that all applications correct-
ly detect this key. If the dongle is not detected all saving/posting options are disabled. 
 

USB Type Dongle 
 
 
 

 

 The SafeNet system driver is automatically installed by the 
EZCAM setup. Manual driver installation is only  
necessary in case the automatic driver installation during 
the EZCAM setup fails ! 
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MANUAL KEY-DRIVER INSTALLATION 
As mentioned previously, manual driver installation is only necessary in case the auto-
matic installation fails or a driver update is required. 
 

 

 You must login using an account with administrator  
privileges to install software drivers under Windows XP / 
Vista / 7. 

 Remove the USB key from the computer before starting 
the driver setup. 

 
 
Procedure: 
 

1. Start Windows Explorer. 
 

2. Navigate to the ‘Rainbow’ folder located in the EZCAM installation directory. 
 

3. Double-click ‘Setup.exe’ to start the Rainbow Technologies Setup. 
 

4. Select the ‘Complete’ installation and click "Next" to continue. 
 

5. Finally select the ‘Finish’ button to exit Setup. 
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TECHNICAL SUPPORT 
Software purchased directly from EZCAM Solutions Inc. includes 1 year of technical 
support and maintenance. 
 
 

 

As our technical staff uses current versions of the product it is 
highly recommended that you upgrade when new major releases, 
fixes or incremental patch updates become available. Only then, 
we can guarantee that our application expertise in the form of ex-
ample files, posts, etc. can be applied without any incompatibili-
ties. 

 
 

UPDATE INFORMATION 
As with any software purchase, to get the most out of your investment and to ensure the 
years of trouble free service and support, it is highly recommended that you upgrade 
when new major releases become available. As EZCAM enhances the software, all regis-
tered users will be notified by mail of software updates. Updated software will be availa-
ble to registered users at special low prices. You can visit EZ-CAM’s web site at  
www.ezcam.com  for latest information. 
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THE APPLICATION INTERFACE 
The following paragraphs are intended to give an overview of the application interface 
with all its toolbars, list boxes, and command buttons together with some general rules 
for geometry construction. 
 
 

THE MAIN WINDOW 
The graphic below represents the general screen layout for the EZ-CAM applications 
with standard toolbar layout. The purpose of this figure is to show you the locations of 
the most important screen elements that are described on the following pages. In addition 
to that you will learn about toolbars, how and where to input numeric values and much 
more. All this information is very helpful when you later step through the tutorials. The 
EZ-EDM and EZ-TURN screen differs only slightly.  
 

 
 

EZ-CAM Main Window (EZ-MILL Pro) 
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THE TOOLBARS 
The first order of business is to acquaint you with the major features of the EZ-CAM 
screen. Let's start with the toolbars. In the basic layout, you will find several icons (com-
mand buttons) grouped together in so called “toolbars” surrounding the drawing space. 
Each button functions as a shortcut to an actual menu command.  Buttons save you time 
because they eliminate the necessity of searching through menus and submenus. The 
toolbars can be positioned anywhere (floating) within the EZ-CAM screen.  This posi-
tioning is known as "docking".  Left, right, up or down, whatever you choose. 
 

 
 
The buttons have been meticulously designed for ease of recognition.  For example, 
you'll notice the geometry buttons all have the same color scheme. This light green color 
is used for all geometrical elements created in EZ-CAM. After a short period of time 
you'll have these button images memorized.  In the meantime, you'll need to take ad-
vantage of a feature called a tool tip.  When you position the cursor over the button and 
hold it there it momentarily, the name of the button command will be displayed. 
 

 
 
A toolbar can accommodate as many buttons as you wish. It will automatically stretch to 
fit the number of rows or columns that you designate.  When creating toolbars, you have 
control over what goes in them and how they should be named 
 

   
See “Toolbar” section in the “Screen Layout” book of the online 
help for more information about customizing, moving or docking 
of toolbars. 
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SELECTING ELEMENTS 
Whenever you want to perform an action on one or more elements (geometry, path, etc.), 
you have to select them prior to execution of the function. For example, if you want to 
delete an entity from the view port, you must first click the Delete button and then select 
the desired entity. This can be done by selecting (click) each single element using the 
cursor or by placing a selection box (rectangle) around all the desired elements. Only the 
ones that are entirely enclosed in this box are selected and displayed in a dotted style. If 
you select the wrong one just click on this element again and it’s deselected.  
 
 

THE VALUE ENTRY BOX 
 

    
 
Having a look on the pictures above, you'll notice that the caption of the input fields in 
the “Value Entry Box” are changing according to the current input mode and selected 
command. The first three fields are directly related to the selected “point picking” mode 
and normally used for entering X, Y, and Z coordinate values. The only exception is 
shown on the rightmost graphic, where the “Polar Mode “ is activated requiring angular 
and radius inputs. The lowest field is depending on the selected geometry command. If 
you were creating a circle, the Value Entry Box would appear as it does in the first exam-
ple.  The letter "R" stands for Radius.  If you were creating a line at an angle to an exist-
ing line, the “Value Entry Box” would appear as it does in the second example showing 
“A”. The letter “D” stands for distance and is visible when using the “Lines, parallel” or 
“Offset” command. The Value Entry Box takes it's cue from you.  It will change instantly 
to conform to your actions. 
 
There are two ways to input X, Y, Z coordinate information. You can manually type the 
coordinate for each field or you can right-click the mouse to copy the cursor's current 
position in the viewport into each respective coordinate field.  When all of the fields in 
the Value Entry Box contain a value, you can either press the Enter key on your keyboard 
or click the Enter button located below the “Value Entry Box”. The best way to go from 
field to field within the “Value Entry Box” is to apply the Windows navigation standard:  
TAB = forward, SHIFT/TAB = backward; or UP  and DOWN  buttons. 
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THE SELECTION LIST BOX 
The Selection List Box generally changes its content according to the selected command 
or operation (Delete, Blank, etc.). Each time you start an operation where elements or 
entities have to be selected, the selection list box is automatically filled with the appro-
priate items. The list box content can be controlled even further by the use of the discrim-
ination options. By doing this it is for example possible to display only curves or arcs. 
 

 
 

 
 

 
 

 

Curves 
 

Layers Colors Work Step’s 

 
When more than 12 items are present in the Selection List Box, a scroll bar is automati-
cally activated. To select an item, just click once on the item you want. When you are 
prompted to select an entity, a list of selectable ID names will appear in the Selection List 
Box.  In most cases, you may either select the item directly from the view port or click on 
its ID name in the List Box.  For instance, if you wanted to delete a curve, you would first 
click on the Delete button and then either click on the curve in the view port or select its 
Curve ID from the List Box. To edit a specific Work Step simply double-click on the 
corresponding entry in the list and make your changes in the Machining dialogs (for fur-
ther information about Work Step reordering using the List Box, please see “The Spread-
sheet” section). 
 
 

THE STATUS BUTTONS 
The Status buttons are located at the bottom of the screen. They are used to display and 
change current status information. For example you may want to change the curve that is 
assigned to the current Work Step displayed on the “Wk Step” button. In this case select 
the “Path” status button and select one of the available curves in the view port or from the 
selection list box. The ID of the newly selected curve will now be displayed on the 
“Path” button.  
 

 
This button displays the currently active layer and is also used to switch layers when 
pressed. The available layers are then displayed in the Selection List Box for being se-
lected with the cursor. 
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This button displays the currently active User Coordinate System and is used to switch 
between available UCS systems. When selected, all available UCS systems will be dis-
played on the screen and in the Selection List Box. Use the cursor to select the desired 
UCS system in the view port or from the list box. 
 
 

   
Important ! 
XYZ coordinate input is directly related to the coordinate system 
that is displayed on the “UCS” status bar. If no user defined UCS 
is available the “World” system will be displayed by default. 

 
 

 
This button displays the currently active Curve ID. To change the currently active curve, 
simply click on the “Curve” status button and select one of the available curves in the 
view port or from the selection list box. 
 
 

   
Curve creation and editing commands are only applied to the 
curve displayed on the curve status button. Therefore it is very 
important to select the correct curve before executing any curve 
editing or creation commands. 

 
 

 
Now here's an interesting button.  Actually, it's two buttons in one.  The button on the left 
is used to display or change the current Work Step. The other button opens the “Work 
Step Data” dialog with the currently active Work Step for editing purposes. 
 
 

 
The current display of the “Path” (machined curve) and “MCS” 
(Machine Coordinate System) status buttons directly refer to the 
Work Step ID displayed on this status button. Before applying any 
changes make sure that the appropriate Work Step is selected. 
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This button is used to display and change the curve (path) that is assigned to the currently 
active Work Step that is shown on the “Wk Step” button. 
 

 
This button is used to display and change the Machine Coordinate System that is as-
signed to the currently active Work Step that is shown on the “Wk Step” button. 
 
 

THE SCREEN PROMPT 
The screen prompt is located at the very bottom of the screen.  You'll find it necessary to 
refer to the prompt when working. 
 
 

 
 
 
Here's a condensed version of the screen prompt.  In this example, a line using the “Line, 
two Points” command is being created.  The left-hand portion of the screen prompt tells 
you the purpose of the button or menu command.  The right-hand portion of the prompt 
tells you what to do.  In this example, once the first point has been picked or entered, the 
prompt will give more instructions for the second point. 
 
 

THE COORDINATE INDICATOR AND THE SIZING HANDLE 
At the bottom right-hand corner of the screen (adjacent to the screen prompt) is the coor-
dinate indicator.  It gives you the exact X, Y, and Z coordinates of your cursor position.  
The coordinate indicator changes constantly as you move your cursor around the view 
port.  
 
 

 
 
 
To the right of the coordinate indicator is a little triangle.  This little triangle is known as 
the sizing handle.  If you want to resize the EZ-CAM main window, first position your 
cursor on the sizing handle.  Then hold the mouse button down and drag the window until 
it is the size you want. 
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THE SPREADSHEET 
Located on the lower portion of the main window is the spreadsheet. Each spreadsheet 
column contains valuable machining data that you can edit locally or globally. In the 
spreadsheet you can activate/deactivate/reorder or delete previously defined Work Steps. 
Reordering can be accomplished by using UP  and DOWN  keys after selecting the 
entire row of the Work Step by clicking in its leftmost ID column. 
 

   
Alternatively, Work Step activate/deactivate/reorder operations 
can be handled using the Work Step Selection List Box in the 
toolbar. You can activate/deactivate a Work Step by clicking on it 
with the right mouse button. In order to move a Work Step up or 
down, first select it with left click and then use LEFT  or 
RIGHT  keys on the keyboard. 

 
One way of making the spreadsheet visible is to select the Show Spreadsheet command 
from the “Work Step” menu which automatically sets its size according to the number of 
work steps. Now we will show you another way to make the spreadsheet visible: 
 
Place your cursor just above any of the buttons at the bottom of the screen.   
 
 

 

 
 
 

When the mouse pointer changes to    , drag it up to the position you want. 
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SCREEN TOOL TIPS 
As we previously mentioned, every button has a tool tip.  When you position the cursor 
over a button momentarily, the tool tip is activated and the name of the button is dis-
played.  Tool tips come in very handy when you are getting accustomed to a new soft-
ware package. We've taken the concept of tool tips and applied them to Surfaces, Curves, 
and User Coordinate Systems.  How does this benefit you? We'll explain. 
 

 
 
 

 

 
 

Curve ID 
 

Surface ID 

 
 
In EZ-CAM, by default blue lines represent curves.  In a complex part, with let's say 30 
curves, a real problem arises.  One blue line looks exactly like another.  The screen tool 
tip becomes extremely useful to you when you need to differentiate one entity from an-
other. 
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DYNAMIC VIEW COMMANDS 
The standard views that are available via the “View” menu or the corresponding Icons in 
the “View” toolbar are sufficient for most cases. Sometimes however, it is desirable to set 
the view direction to a freely chosen angle. This option is available in EZ-CAM through 
dynamic viewing commands. The current view can be changed by using any of the dy-
namic “Rotate”, “Zoom” or “Pan” functions. 
 
When selecting dynamic viewing commands one of the following cursors will be dis-
played. 
 

  
Rotate Pan Zoom 

 
Hold the left mouse button down then drag the mouse across the screen. The part will 
directly follow the cursor movements according to the command selected. When you 
release the mouse button the screen will be re-drawn in the new Orientation. In idle mode 
when no EZ-CAM command is active (pressing ESC key aborts the current command) 
holding right mouse button down and dragging applies dynamic rotation; holding middle 
button down and dragging applies panning; rotating mouse wheel forward / backward 
zooms in and out. 
 

 
Dynamic Rotate Dynamic Zoom Dynamic Pan
 
 

 
Dynamic Rotate 
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RULES FOR GEOMETRICAL CONSTRUCTION 
Geometry is always based on the currently active coordinate system (World or User de-
fined coordinate system, also referred to as UCS). When several alternative solutions to a 
construction exist, moving the screen cursor will show the alternative that lies closest to 
the cursor position in white. When the correct solution is shown, a click with the left-
hand mouse button will carry out the construction (this function is called dynamic pre-
view). 
 
 

GEOMETRY - DYNAMIC PREVIEW FUNCTION 
The geometry construction has been provided with a Dynamic Preview Function. This 
function provides a visual check on the construction before it is actually performed. If 
there are several solutions to a construction (which is often the case) moving cursor on 
the screen will select the nearest solution and the new element will be shown highlighted. 
When the correct solution is shown, a click with the left-hand mouse button will carry out 
the construction and the new element will be drawn. 
 
In the following example we will look at the construction of a circle that must lie tangen-
tial to three existing circles. If you look at the graphic below you can see that two tangent 
points on circles A and B have already been chosen. The final construction has two pos-
sible solutions, depending upon which side of the third circle is picked. As the screen 
cursor is moved nearest to one side or the other, the possible new circle will be highlight-
ed. A click with the left-hand mouse button will confirm the selection and the circle will 
be drawn on the screen. 
 
 

Tangential Points #1 and  #2 on

the outside of Circles A and B

already selected

Cursor Position 1 to select Point #3
outside of Circle C

Circle A

Circle B

Circle C

Cursor Position  2 to select
Point #3 inside of Circle C

Result 2

Result 1

Circle, 3 Points

Tangency Pick Mode
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DEFINING A POINT 
Whenever you have to define a point, no matter if it’s an endpoint of a line or the center 
of a circle, you have two choices. You can use one of the SNAP Modes by selecting the 
corresponding icon on the toolbar or input the values directly in the fields of the “Value 
Entry Box”. 
 

 

Value Entry Box 
 
When you want to use coordinate input, just click in one of the input fields (X, Y, Z). 
You can move between these fields by using the TAB or UP  / DOWN  keys and input 
the desired values. After all values are input press ENTER. The point will be accepted 
and displayed by the system. 
 
You may be wondering what SNAP modes are. Here is a picture of the standard SNAP 
Mode toolbar with the modes named. 
 
 

 
 
 
These are the most commonly used snap modes to pick an existing point on the screen, 
for example the endpoint of a line, a tangential point or the intersection between two ge-
ometry elements. 
 
Here is how it works: first choose the type of element you want to create. Then select the 
appropriate snap mode icon in the toolbar and move the cursor to the desired point on the 
screen. The software will automatically snap to the closest point and the dynamic preview 
will display the result on the screen. If this is the point you want to select, just click the 
left mouse button and the point will be yours. 



CHAPTER 1 

1-20 EZ-CAM 

CIRCLE / ARC CONSTRUCTION 
The graphical user interface is streamlined by combining circle and arc construction into 
the same button command. The buttons shown below are used for creating circles and 
arcs.  
 
 

 
Circle/Arc, Center, Radius Circle/Arc, Center Edge 
  

 
Circle/Arc, Two Points, Radius Circle/Arc, Three Points 
 
 
The most common of them are available on the standard button layout while the others 
are accessible through the “Geometry” menu.  By default, clicking any of these buttons 
will result in a circle.  To create an arc, you'll need to click the “Finite” Mode button 
shown below or the corresponding command in the “Geometry” menu.  This command 
functions as a toggle between infinite and finite geometry construction. 
 

 
Finite Mode 
 
Remember, if you don't want to go around in circles, click the “Finite” Mode button. 
 
 

   
The “Finite Mode” also applies to the “Line, parallel” and “Line 
at Angle” line creation commands. 

 
Line, parallel Line at Angle 
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OVERVIEW 
This tutorial is intended for users with little, or no experience in EZ-Mill operations. The 
step-by-step instructions describe the complete process of creating the NC program for 
the 2D part shown in Picture 2-1, focusing on the machining process and also describing 
more advanced techniques used for roughing, finishing and Work Step handling using the 
integrated spreadsheet. In addition we show you how to import CAD data by loading and 
arranging a DXF file. 
 
 

BASIC PROGRAMMING STEPS 
Before we continue with the tutorial let us explain the basic steps needed to create a part 
program with EZ-Mill. 
 
 
STEP 1.  Create Geometry 

Start by creating part geometry via commands under the Geometry 
Menu, or alternatively, use “File/Open” command to import geometry 
data from CAD sources (IGES, DXF, DWG, etc.) 

 
STEP 2.  Define Path Curves 

Use the “Curves” menu commands like CHAIN, ARC, LINEAR, etc. 
to define curves by tracing or chaining existing geometry. 

 
STEP 3.  Create Work Steps and set Machining Parameters 

Define Work Steps for each machining operation and apply the pa-
rameters as required by type of operation and tool that is used. Assign 
the desired path curve to each Work Step. Visualize the computed tool 
path to assure correct tool operation and proper setting of machining 
parameters. 

CHAPTER 2.  
EZ-MILL 2D TUTORIAL 



CHAPTER 2 

2-2 EZ-CAM 

 
STEP 4.  Post G-Code 

Select the “Postprocessor” related to the type of control and let the 
software create the G-Code file. 

 
 
 
 

   
The EZ-Mill 2D Tutorial is set up in Metric with all Inputs and 

Dimensions in Millimeters ! 
 
Users who want to skip the geometry creation may start with the 
“Import CAD Data” topic at the end of the geometry section.  
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Blueprint of EZ-Mill 2D Tutorial 
 

Picture 2-1 
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DEFINE ORIGIN, WINDOW SIZE AND LOCATION 
The window size is the distance from the edge of the window to the center of the win-
dow. The window location is the signed, absolute position of the window center from the 
part’s origin. The viewing parameters that are found in the Setup dialog box specify the 
size and location of the window. Note that you would not normally perform this step in 
programming a part, but it is necessary here to insure clarity in following the tutorial. 
Normally, you would just use the Zoom/Fade commands to set the window size as need-
ed. 
 
When selecting the origin for the part, choose a location that is referenced by the part’s 
dimensions. The origin should be selected before defining the window location (see next 
topic for setting up the workspace), because the window center is referenced from the 
part's origin. The graphic in Picture 2-2 below shows the location of the part origin for 
this exercise (X = 0, Y = 0). 
 
 
 

Window Size

Window Center

Part Origin

 20 

 10 

X Center

Y Center

 130 

 
 

Picture 2-2 
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SETTING PREFERENCES 
Before continuing with the construction of the sample part, several parameters should be 
set so that the system is compatible with the instructions in this tutorial. Also the size of 
the workspace should be set. The sample part is about 250mm in the X-axis and 85mm in 
the Y-axis. Because of the size of the part, it is not convenient to work in the default win-
dow; therefore the window and some default settings have to be changed. 
 
 
1. Select ”New” command from the “File” menu to restart EZ-Mill and to clear the 

memory before continuing with the tutorial. Make sure that one of the EZ-Mill levels 
is active and press OK to start over. 

 

 
 
 

  
 

The “New” dialog is also used to switch between the EZ-Mill and 
EZ-Turn module. Before the dialog opens, the system checks the 
software protection key for activated modules. Modules or levels 
that are not activated will be marked by appended “DEMO” text. 
When working in “Demo” (evaluation) mode, it is not possible to 
print or save data. The corresponding “Save”,  “Save as” and 
“Print” commands are disabled. 
 
When closing the EZCAM application, the system automatically 
stores the last used level as default for the next session. 

 
2. Select ”Setup” command from the “View” menu 

 

3. Type “20” for “X Center”, “-10” for “Y Center” and “130” for “Size”. 
This sets the window size from the edge of the window to the center of the window, 
allowing enough room to see all of the part as it is created. See Picture 2-2. 
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4. Select “Metric” option button as the parts input dimension system. 

 

5. Click the “Background” list box and select “Black”. 

 

6. Check the box "Blank Verify" on the right. This will cause verified tool paths to be 
blanked every time the view is changing or the screen is redrawn. 

 

7. Check the box  "Save as Default". The system will store all dialog settings as de-
faults for future sessions. 

 

8. After the preferences have been correctly set, click OK. 

 
 

 
 
 
 
The initial setup for the EZ-MILL 2D tutorial is now complete. Continue with the next 
section to create the geometry necessary for this part. 
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THE PART GEOMETRY 
Now that the workspace has been adjusted to accommodate the part, the creation of the 
part can begin. This involves creating geometry that is used to define the tool paths. Be-
fore you begin check that the current view is set to X-Y. 
 

To change system view to X-Y, click the X-Y view    button. 
 
First, we will create the geometry that defines the outside contour of the sample part. 
Then we continue with creating the pockets. At any time you may use the Undo/Redo 
buttons in the upper left corner to correct any mistakes you make. 
 
 

DEFINING CIRCLES 
Follow these steps to create the first circles that define the basic geometry of the sample 
part. 
 
1. Select the “Circle/Arc, Center, Radius” button. 

Circle/Arc, Center, Radius 
 
2. For the Radius of circle #1, type “15” in the “R” field of the Value Entry Box on the 

lower right side of the EZ-Mill screen. Make sure the X, Y, Z coordinate values are 
set to “0” (default value). 

 

 
 
3. Press the ENTER button (The first circle should be displayed at the part origin).  
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4. For the Radius of circle #2, type “22” in the “R” field of the Value Entry Box. As the 
center coordinates of the second circle are same (X0/Y0), simply press the ENTER 
button to create the second circle. 

 

5. For the Radius of circle #3, type “12” in the “R” field of the Value Entry Box, then 
press Tab to move the focus to the “X” input field. Type “135” for the Center X loca-
tion. Y position should already be set to “0”. Press the ENTER button to create third 
circle. 

 

6. To create circle #4, press Tab until focus is set to the “Y” input field. Type “-15” for 
the Center Y location and press the ENTER button. 

 

7. To create circles #5 and #6 we use the “polar coordinate” input mode. Select the “Po-
lar Mode” option located in “Edit / Point Picking” menu. When selected you will see 
a small checkmark in the menu indicating the option is activated. Every selection of 
this menu entry toggles the polar mode “On” or “Off”. 

Polar Mode 
 

8. The content of the Value Entry Box will change as shown below. Input “210” in the 
“A” field as the polar angle and “105” in the first “R” field as the polar radius to 
specify the center of the circle #5 by using polar coordinates. In the second “R” field 
input “10” for the radius of the new circle itself and press ENTER button. The polar 
origin is always located at the origin of the current coordinate system.  
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9. To create circle #6, change the radius value to “6” and press ENTER. Now your part 

geometry should appear as in Picture 2-3. Do not forget to toggle the “Polar Mode” 
to “OFF” condition when finished. 

 
 

Circle 1 (R15)

Circle 5 (R10)

Circle 2 (R22)
Circle 6 (R6)

Circle 4 (R12)

Circle 3 (R12)Part Origin
Y

Z X

 
 

Picture 2-3 
 
 
 

DEFINING TANGENTIAL LINES 
The next step is to define tangent lines to connect the R10, R22 and R12 circles. 
 
1. First select the “Line , Two Points” ,then the “Tangency” button. 

 
Line, Two Points Tangency 

 
2. When the "Pick First Point" prompt displays in the message area, click slightly above 

the R10 circle #6 (see POS #1 in Picture 2-4). 

 

3. Then the "Pick Second Point" prompt displays. Now move the cursor to the right, 
slightly above the R22 circle (see POS #2 in Picture 2-4).  The geometry preview 
will show the next possible line. If it is OK confirm the action with a mouse- click. 
The new line is drawn tangent between the R10 and R22 radius circles. 
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POS #1

POS #2

New Line drawn by the
Dynamic Preview 
 

POS #3
POS #4

POS #5

POS #6

POS #7

POS #8  
 

Picture 2-4 

 
 
 
4. Continue with creating lines by selecting POS #3 and POS #4 to connect the R22 and 

R12 circle, POS #5 and POS #6 to connect both R12 circles, POS #7 and POS #8 to 
connect the R22 with the R10 circle again. See Picture 2-5 for the resulting geome-
try. 

 
 
 

Y

Z X

 
 

Picture 2-5 
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CREATING LINE AT ANGLE 
The next step is to define a line that lies tangential to the R12 circle at an angle of 3 de-
grees to the X-axis. 
 
1. Select the “Line at Angle” button. 

Line at Angle 
 
2. Click the X-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 

 
Y

XZ

Cursor Position to
select X Axis

 
 

3. Type “3” in the “A” field of the  Value Entry Box (Do not press ENTER). 

 
4. Select the “Tangency” button. 

Tangency 
 
5. Move the cursor to a position slightly below the R12 circle as shown in Picture 2-6. 

The geometry preview will show the new line. If it is OK confirm the action with a 
mouse click. 

 

Cursor Position to select
tangent Point on Circle

 

New Line drawn by the
Dynamic Preview 

Y

Z X

 
 

Picture 2-6 
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REMOVING LINE SEGMENTS 
Follow the instructions below to remove some of the line segments. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

Remove to Closest 
 
2. At the "Pick Line, Arc or Circle" prompt, select the line segments to be removed as 

shown in Picture 2-7. The result should appear as in Picture 2-8. 

 
 

Cursor Positions to remove
Line Segments

 

Y

Z X

 
 

Picture 2-7 
 
 

 

Y

Z X

 
 

Picture 2-8 



EZ-MILL 2D TUTORIAL 

EZ-CAM 2-13 

CREATING LINE AT ANGLE 
The next step is to define a line that lies tangential to the R22 circle at an angle of 3 de-
grees to the X-axis. 
 
1. Select the “Line At Angle” button. 

Line at Angle 
 
2. Click the X-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 

             

Y

XZ

Cursor Position to
select X Axis

 
 

3. Type “3” in the “A” field of the Value Entry Box (Do not press ENTER). 

 
4. Select the “Tangency” button. 

Tangency 
 
5. Move the cursor to a position slightly below the R22 circle as shown in Picture 2-9. 

The geometry preview will show the new line. If it is OK confirm the action with a 
mouse click. 

 
 

 

Y

Z X

Cursor Position to select
tangent Point on Circle

New Line

 
 

Picture 2-9 
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CREATING A CORNER FILLET 
Now we're going to create a corner fillet between two lines meeting below the R22 radius 
circle. 
 
1. Click the “Corner Fillet” button.  

Corner Fillet 
 
2. When the Value Entry Box prompts for a radius value, type “40” in the “R” field. 

 
3. At the "Pick int. of two lines, arcs or circles" prompt, move the cursor to the inside of 

the intersection between the two lines as shown in Picture 2-10. Pausing the mouse 
over the corner without clicking, the dynamic preview will show the fillet to be in-
serted. Clicking there will actually insert the fillet. 

 
 
 

 

Y

Z X

Cursor Position to select
Corner Fillet Position

 
 

Picture 2-10 
 
 
 
 



EZ-MILL 2D TUTORIAL 

EZ-CAM 2-15 

DEFINING PARALLEL LINES 
Now we will create some help geometry to find the center of the R10 circle 70mm to the 
right of the part origin. First we define a line that lies parallel to the Y-axis at a distance 
of 70mm. Then we create a line with a distance of 10mm to the 3° angled line starting at 
the R40 corner fillet in the lower part of the geometry. 
 
1. First select the “Line , Parallel” button. 

Line, Parallel 
 
2. For the parallel distance type “70” in the “D” field of the Value Entry Box. 

(Do not press ENTER). 

 

3. Move the cursor to the right side of the systems Y-axis coordinate handle as shown 
in Picture 2-11. The geometry preview will show you a line parallel to the Y-axis 
with a distance of 70mm. If the preview is OK confirm with a mouse click. 

 
 
 

 

Y

Z X

New Parallel Line

 70 

 

Cursor Position

 
Picture 2-11 
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4. For the second parallel line type “10” in the “D” field of the  Value Entry Box. 

(Do not press ENTER). 

 

5. Move the cursor to a position below the 3° line as shown in Picture 2-12. The geom-
etry preview will show you the new parallel line with a distance of 10mm to the se-
lected line. If the preview is OK confirm with a mouse click. 

 
 
 

 

Y

Z X

Cursor Position

New Parallel Line

 10 

 
 

Picture 2-12 
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DEFINING CIRCLE 
Next step is to define the R10 circle at the intersection of the newly created parallel lines 
(help-geometry) by specifying its radius and center location. 
 
1. Select the “Circle/Arc, Center, Radius” button and the “Snap All” pick mode. 

Circle/Arc, Center, Radius Snap All 
 
2. For the Radius type “10” in the “R” field of the Value Entry Box. 

 

3. Move the cursor to the intersection of the two parallel lines like shown in Picture 2-
13. The geometry preview will show you a circle moving on the screen along with 
your mouse cursor. When the software snaps to the correct position and the preview 
is OK confirm with a mouse click to create the circle. 

 
 
 

 

Y

Z X

Cursor Position

New R10 Circle

 
 

Picture 2-13 
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DELETING ELEMENTS 
Next we delete the two parallel lines we just created to get the circles center location.  
 
1. Click the “Delete” button. This command allows you to delete elements. 

Delete 
 
2. Check that the “Verify” mode button is pressed (set to “On”). When a group com-

mand like “Delete” is selected, the “Verify Off” (button up) mode executes the 
command immediately after you select an entity. The “Verify On” mode (button 
down), highlights each of the entities as you select them and does not execute the 
command for these entities until you click the ENTER button. This allows you to se-
lect more than one entity and to verify your selections. 

Verify Mode 
 
3. Select the two lines as shown in Picture 2-14 and press the ENTER button to delete 

them. 

 

   
 Inadvertently selected elements can be deselected with a mouse-
click (selecting same entity again). 

 
 

 

Y

Z X

Cursor Position to Delete
the linear Elements

 

 
Picture 2-14 
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DEFINING TANGENTIAL ARC 
Follow these steps to create the R10 arc that fills the corner of the existing R10 circle and 
the angled line. This is accomplished by specifying the radius and two points that lie tan-
gential on both elements. For the result see Picture 2-15. 
 
1. Select the “Circle/Arc, Two Points, Radius” button. 

Circle/Arc, Two Points, Radius 
 

2. Select the “Finite Mode“ option located in “Geometry” menu. For all Circle/Arc 
commands, “Finite Mode” OFF creates circles, ON creates arcs. When selected you 
will see a small checkmark in the menu indicating the option is activated. Every se-
lection of this menu entry toggles the finite mode “On” or “Off”. 
 
! Do not forget to “uncheck” this option after the arc has been created ! 

 

3. For the Radius type “10” in the “R” field of the Value Entry Box. 

 

4. Select the “Tangency” button. 

Tangency 
 
5. Move the cursor to the right side of the existing R10 circle as shown in Picture 2-15 

and click the mouse. The circle will be displayed in dotted style after being selected. 
Now move the cursor to a position slightly above the angled line. The geometry pre-
view will show the new arc when moving the cursor to this position. Confirm the ac-
tion with a mouse click. See Picture 2-15 for the result. 
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Y

Z X

Cursor Positions to create 
tangent R10 Circle

 
Picture 2-15 

 
 
 

REMOVING LINE/ARC SEGMENTS 
Follow the instructions below to remove some parts of the geometry to clean up and fin-
ish the outside profile of the part. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

Remove to Closest 
 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be re-

moved until the result appears as in Picture 2-16. 

 

 

Y

Z X

 
Picture 2-16 
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DEFINING PARALLEL LINES 
Now we continue with creating the pocket on the right side. First we need two parallel 
lines with a distance of 3mm to the existing angled lines. In addition we also need a line 
offset 60mm to the right of the Y-axis. 
 
1. First select the “Line Parallel” button. 

Line, Parallel 
 
2. For the distance type “3” in the “D” field of the Value Entry Box. 

(Do not press ENTER). 

 

3. Move the cursor to the POS #1 slightly above the angled line as shown in Picture 2-
17. The geometry preview will show you a parallel line at a distance of 3mm. If the 
preview is OK confirm with a mouse click. Repeat the same at POS #2. 

 

4. Now type “60” in the “D” field of the Value Entry Box (Do not press ENTER). 

 

5. Move the cursor to the right side of the systems Y-axis coordinate handle as shown 
in Picture 2-17. The geometry preview will show you a line parallel to the Y-axis 
with a distance of 60mm offset to the right side. Confirm with a mouse click if the 
preview is OK. 

 
 

 

Y

Z X

 60 

 3 

 3 

New Parallel Lines

POS #1

POS #2

POS #3

 
Picture 2-17 
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CREATING CORNER FILLETS IN POCKET 
Now we're going to create corner fillets inside the right pocket. 
 
1. Click the “Corner Fillet” button.  

Corner Fillet 
 
2. When the Value Entry Box prompts for a radius value, type “6” in the “R” field. 

 

3. At the "Pick int. of two lines, arcs or circles" prompt, move the mouse to the four 
positions shown in Picture 2-18. The dynamic preview will show the fillet to be in-
serted. Clicking there will actually insert the fillet. 

 
 
 

Y

Z X

Cursor Positions to insert Corner Fillets

 
 

Picture 2-18 
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REMOVING (TRIM) LINE SEGMENTS 
Follow the instructions below to remove some parts of the geometry to clean up the right 
pocket profile. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

Remove to Closest 
 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be 

trimmed until the result appears as in Picture 2-19. 

 
 
 

Y

Z X

 
 

Picture 2-19 
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DEFINING PARALLEL LINES 
Now we continue with creating the pocket on the left side of the part. Again we need two 
parallel lines with a distance of 3mm to the existing angled lines. 
 
1. First select the “Line Parallel” button. 

Line, Parallel 
 
2. For the distance type “3” in the “D” field of the Value Entry Box. 

(Do not press ENTER). 

 

3. Move the cursor to the POS #1 slightly above the angled line as shown in Picture 2-
20. The geometry preview will show you a parallel line at a distance of 3mm. If the 
preview is OK confirm with a mouse click. Repeat the same at POS #2. 

 
 
 

Y

Z X

New Parallel Lines

POS #1

POS #2

 
 

Picture 2-20 
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CREATING LINE AT ANGLE 
For the lower pocket boundary we need a line angled at 30 degrees to the Y-axis with a 
distance of 80mm to the part origin as shown in Picture 2-21. 
 
1. Select the “Line At Angle” button. 

Line at Angle 
 
2. Click the Y-axis coordinate system handle with the mouse to define the reference 

axis for the angle. 

  
Y

XZ

Cursor Position to
select Y Axis

 
 
 
3. Type “30” in the “A” field of the Value Entry Box  (Do not press ENTER). 

 
4. To define the point through which the angled line will move we select the “Polar 

Mode“ option located in “Edit /Point Picking” menu. When selected you will see a 
small checkmark in the menu indicating the option is activated. Every selection of 
this menu entry toggles the polar mode “On” or “Off”. Do not forget to toggle the 
“Polar Mode” to “OFF” condition when finished. 

Polar Mode 
 

5. The content of the Value Entry Box will change as shown below. Input “-150” 
(“210” also possible) in the “A” field as the polar angle and “80” in the “R” field as 
the polar radius to specify the point for the angled line. Then press the ENTER but-
ton to create the new line. See Picture 2-21 for the result. 
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Z X

 150° 

  80  

New Line

Point defined by Polar Coordinates

 30° 

 
 

Picture 2-21 
 
 
 
 

CREATING CORNER FILLETS IN POCKET 
Now we're going to create the corner fillets inside the left pocket. 
 
1. Click the “Corner Fillet” button.  

Corner Fillet 
 
2. When the Value Entry Box prompts for a radius value, type “6” in the “R” field. 

 

3. At the "Pick int. of two lines, arcs or circles" prompt, move the mouse to the posi-
tions shown in Picture 2-22. The dynamic preview will show the fillet to be inserted. 
Clicking there will actually insert the fillet. 
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Y

Z X

Cursor Positions to insert Corner Fillets

 
 

Picture 2-22 
 
 

REMOVING (TRIM) LINE SEGMENTS 
Follow the instructions below to clean up the left pocket profile. 
 
1. Click the “Remove to Closest” button. This command will allow you to remove a 

segment of a line, arc, or circle between the closest boundaries. 

Remove to Closest 
 
2. At the "Pick Line, Arc or Circle" prompt, select the line and arc segments to be 

trimmed until the result appears as in Picture 2-23. 

 
Y

Z X

 
 

Picture 2-23 
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The following two topics explain how to import and move geome-
try from a CAD source by loading a DXF file. If you have already 
created the geometry by following the previous topics please jump 
to the “Creating the Boundary Rectangle” topic to add the frame 
needed as the pocket boundary for roughing the outside profile. 

 
 
 

IMPORT CAD DATA (LOADING DXF FILE) 
This section shows how to import and arrange CAD data to be machined with EZ-Mill. 
As an example we will import a CAD file in DXF format. The file named “MILL-
TUTORIAL.DXF” was copied to your computer by the setup program and is located in 
the “EZCAMW \ MILLPARTS” folder. 
 
 

 
 

Picture 2-24 
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1. Select “Open” command from the “File” menu to open the file dialog. In Picture 2-

24 you can see the dialog displayed on a Windows XP professional workstation sys-
tem. This dialog may vary according to the version of the Windows operating sys-
tem running on your machine. 

 

2. Select the folder “EZCAMW \ MILLPARTS” on the drive where you installed the 
software 

 

3. In the ”Files of Type” list select “AutoCAD (*.DWG; *.DXF)”. 

 

4. Select the file “MILL-TUTORIAL.DXF” and click the “Open” button. The imported 
geometry should appear as in Picture 2-25. 

 
 
 

Y

Z X
CAD Origin  

 
Imported DXF geometry 

 
Picture 2-25 

 
 
 

   
If possible, remove all unnecessary geometry, views, dimensions, 
etc. from the drawing in the CAD system before exporting data in 
DXF or other exchange format. This will reduce file size and 
amount of work necessary to remove these entities within EZ-
Mill. 
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MOVING IMPORTED DATA 
Picture 2-25 shows the imported CAD geometry. You can see that the origin is different 
to what we need (see “Selecting an Origin for the part” section at the beginning of the 
tutorial). Therefore we will show you how to move the geometry so that the work origin 
is in the center of the 30mm DIA. circle. 
 
1. Click the “Move” command from the “Edit” menu. This command allows you to 

move selected elements by defining initial and target position (from.. to..). 

 
2. Check that the “Verify” mode button is pressed (set to “On”). 

Verify Mode 
 
3. At the “Pick from Point” prompt select the “Center Circle” pick mode and click the 

Dia.30mm circle as shown in Picture 2-26 (POS #1) in order to select the center 
point as the “Initial Point”. 

Center Circle 
 

4. At the “Pick to Point” prompt select the “Snap All” pick mode and click the origin of 
the “World” coordinate system (POS #2) as the “Target Point”. 

Snap All 
 

Y

Z X

POS #1
Select Circle as "Initial Point"
(Software snaps to Center Point)

POS #2
Select the Express "World" origin as Target Point  

 
Picture 2-26 
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5. Click the “Select All” command from the “Edit” menu. This command will select all 

existing elements in the view port. Then press the ENTER button. The geometry is 
moved to the new location as shown in Picture 2-27. 
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Picture 2-27 
 
 
 
 

CREATING THE BOUNDARY RECTANGLE 
The last thing to do is to create a rectangle that will later serve as the pocket boundary for 
the first Work Step where the outside profile will be rough machined. 
 
1. Select the “Rectangle, Corner to Corner” command from the geometry menu. This 

will allow you to create a rectangle by defining two opposite corner locations. 

 

2. For the first position type “-110” in the “X” field of the Value Entry Box. Use the 
TAB button to switch to the “Y” field and type “30”. Then press ENTER to verify 
the first position. 

 

3. To define the second position use the TAB button to select the “X” field again and 
type “160”. Continue to the “Y” field and type “-70”. Make sure that the “R” and 
“Z” values are set to “0”. Then press ENTER. The result should appear as in Picture 
2-28. 

 



CHAPTER 2 

2-32 EZ-CAM 

 
Y

Z X

POS #1
[ X-110.0 / Y30.0 ]

POS #2
[ X160.0 / Y-70.0 ]

 
 

Picture 2-28 
 
 
 
 

   
If you want to save the newly created geometry before continuing, 
jump to the “Save Part Program” section at the end of the tutorial. 
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THE PATH CURVES 
Before we continue with the path curve creation we will give you a short explanation 
about what a path curve is. Each Work Step needs a profile or shape the tool follows in 
some way. Therefore a path (curve) has to be assigned to every Work Step following cer-
tain rules determined by the selected machining cycle (Contour, Pocket, Drilling, etc.). 
For example it is allowed to define an open path when using the “Contour” feature, 
whereas a “Pocket” path always has to be closed. 
 
As any path is represented by curves within EZ-CAM it is important to know that the 
software makes use of the curve entity in several different ways. It can be used as a sim-
ple tool path for contouring, as a machining boundary to define a pocket or an island, or it 
may be used to define a surface (Mill / Mill-Pro levels only). All of these uses for the 
curve make it a very flexible and powerful feature. For example you can create multiple 
Work Step’s to machine the same curve for roughing and finishing or Spot-Drilling with 
subsequent Drilling operations. 
 
A curve can be a straight line, an arc, a spline, or a combination of these things. It may 
include "rapid" moves, or it may be a single point. The curve does not have to follow any 
specific rules on its own, but as mentioned above, certain rules determined by the desired 
operation and the selected machining cycle have to be followed.  
 
 
For this tutorial we have to create 5 Curve entities: 
 

1. Boundary curve (rectangle) representing the outside boundary when 
roughing the part (leaving 0.2mm stock allowance for finishing). 

2. Contour curve for the parts outside shape 

3. Pocket curve 1 for the circular pocket 

4. Pocket curve 2 including the left and right side pockets 

5. Drilling curve representing the 12mm DIA hole position 

 

   
You will have to assign a unique ID to each curve that is created. 
Use your own ID’s or the systems default (Crv1, Crv2, etc.). 
When working on extensive projects it is always good to use ID’s 
that can be easily remembered and that reflect the purpose of the 
curve. 
 
Important ! 
Don’t use space or any other special characters in the curve ID. 
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POCKET PATH CREATION RULES 
This tutorial uses “Pocket” and “Zig-Zag” cycles for roughing of the outside and inside 
pocket profiles. Below you find a list of the most important rules to be followed when 
creating curves to be used in conjunction with one of these cycles. 
 
 “Pocket” and “Zig-Zag” cycles always need a closed boundary curve (same start & 

endpoint). 
 
 The boundary may start with a rapid move to define the plunge location. 
 
 No rapid move within the boundary profile itself is allowed. 
 
 If a pocket contains any islands, there are two ways to define these: 
 

 Include boundary and islands in one single curve. The islands are directly ap-
pended to the boundary curve by rapid moves. Boundary and all island profiles 
have to be closed shapes. 
 
The element sequence of a curve including boundary and 2 islands follows. 

 
Boundary Profile -> Rapid Move -> Island1 -> Rapid Move -> Island 2 

  
 Create separate curves for boundary and islands. When creating the Work Step 

later, select the boundary curve in the “Path ID” list box and all islands in the 
“Check Curves” table. The result will be the same as mentioned before but the 
advantage is that there is no need to define different curves for rough and finish-
ing operations. 

 
The tutorial will make use of the second method creating separate curves for 
boundary and island profiles. 

 
 A circular boundary or island must contain at least three points (two arc elements).  
 
 
 

  
See the EZ-Mill Help for more information about “Pocket“ paths. 
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CREATING THE BOUNDARY CURVE 
For the first rough machining operation we need a curve that represents the pocket 
boundary. We will use the existing geometry rectangle to define the curve. 
 
 
1. First we have to create a new curve. Therefore select the “New” command from the 

“Curves” menu or click the corresponding button. In the dialog that opens type 
“Boundary” as the new ID and confirm with OK. 

 
New 

 
2. To define the boundary profile we use the “Chain” option. Select the “Chain” com-

mand from the “Curves” menu or click the corresponding button. 

Chain 
 
3. The prompt “Select First Line or Arc” is displayed at the bottom edge of the window. 

Move the cursor to Position as shown in Picture 2-29 and double-click the mouse to 
select the line as the first element in the curve chain. The software automatically 
completes the curve by following the connecting geometry elements from the first 
point to the last. 
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Z X

Cursor Position to select first boundary
element to be "Chained"  

 
Picture 2-29 
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 The position where the first element is selected is very important to the direction of 

the curve. The items between the selected elements are automatically completed by 
the software and displayed as shown in Picture 2-30. A small arrow referred to as 
the “direction indicator” shows the path direction. 
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Z X

Completed "Boundary" Curve  
 

Picture 2-30 
 
 
 

CREATING THE CONTOUR CURVE 
Now we create the curve that represents the outside profile of the part. This curve will 
later be used as island for roughing and as contour curve for the finishing Work Step. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “ODContour” as the new ID and confirm with OK. 

 
New 
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2. Select “Chain” from the “Curve” menu or click the corresponding button. Move the 

cursor to Position as shown in Picture 2-31 and double-click the arc near by its start 
point to select this entity as the first element in the curve chain. The software auto-
matically completes the curve resulting in a clockwise direction as shown in Picture 
2-32. 

Chain 
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Z X

Cursor Position to select the Arc as
the first Element of the "ODContour" Curve  

 
Picture 2-31 
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Completed "ODContour" Curve

 
 

Picture 2-32 
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CREATING THE POCKET1 CURVE 
Next comes the creation of the curve representing the circular pocket. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Pocket1” as the new ID and confirm with OK. 

 
New 

 
2. Select “Chain” from the “Curve” menu or click the corresponding button. Move the 

cursor to Position as shown in Picture 2-33 and double-click the arc. The software 
automatically creates a circular curve in counter-clockwise direction with the start at 
the 0 degree position. The result is shown in Picture 2-34. 

Chain 
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 Double Click at Cursor Position to select
Circle for "Pocket1" Curve

 
 

Picture 2-33 
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Completed "Pocket1" Curve

 
 

Picture 2-34 
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CREATING THE POCKET2 CURVE 
Since the remaining two pocket profiles will later be machined using the same tool, tech-
nology and machining parameters, we will combine these two shapes into one single 
curve. The connection is achieved by a rapid link that is inserted automatically by the 
software when the “Chain” command is used multiple times on independent profiles. You 
will also learn how to control the start/end point of the curve as well as the curve direc-
tion. This is very important because both chained profiles need to have the same direction 
if combined into one single curve. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Pocket2” as the new ID and confirm with OK. 

 
New 

 
2. Select “Chain” from the “Curve” menu or click the corresponding button. Then 

move the cursor to the “Pocket A” profile and double-click anywhere along this con-
tour (see Picture 2-35). Do the same anywhere along the “Pocket B” contour. The 
system automatically chains all elements and connects both pocket profiles using a 
rapid move represented by a dotted line between the start points of each of the two 
profiles. Don’t worry about correct start point and curve direction, as we will take 
care of that in the next step. 

Chain 
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Z X

Double-click once anywhere along each of the pocket profiles
to chain the Geometry Elements for "Pocket2" Curve

Pocket A

Pocket B

 
 

Picture 2-35 
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3. In the following step we are going to define the start/end point for both profiles in the 

“Pocket2” curve. First select “Start/End” from the “Curve” menu, then switch to the 
“Midpoint” pick mode from the “Edit/Point Picking” menu. If you now move the 
cursor along the existing “Pocket2” curve profiles the dynamic preview automatical-
ly snaps to the next possible midpoint that can be selected. Click at positions #1 on 
“Pocket A” and #2 on “Pocket B” as shown in Picture 2-36. Make sure to click on 
the inside of the profiles. See Picture 2-36/2 for the result. 

Start/End Pick Midpoint 
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Z X

Cursor Positions inside Pocket Profiles
to select new Start Point Locations

Pocket A

Pocket B
#1

#2

 
 

Picture 2-36 
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Rapid Move connecting both Pocket Paths

 

Start Pocket A

Start Pocket B

 
 

Picture 2-36/2 
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The Start/ End  curve command is only applicable to exist-
ing curves that represent closed profiles. It actually combines sev-
eral important tasks into one single command. 
 
1. Move the Start/End point of existing curve 
In combination with one of the available “Pick” modes it is possi-
ble to select any point (endpoint, midpoint, etc) along the existing 
curve profile as the new start/end location. 
 
2. Specify Curve direction 
If the cursor is positioned inside the closed profile then the curve 
direction is automatically set to counter-clockwise. If outside then 
direction is clockwise. If necessary this can later be changed by 
using the “Reverse Direction” command from the “Curves” menu. 
 
3. Insert Rapid Move (Plunge Point Location) 
If the specified start/end location is not lying on the curve itself 
the system will insert a perpendicular rapid move connecting the 
selected position with the profile. This is later used as plunge po-
sition by the “Zig-Zag” and “Pocketing” cycles. 
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CREATING THE 12MM HOLE CURVE 
Finally the last curve to be created defines the 12mm DIA hole position. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Drill12” as the new ID and confirm with OK. 

 
New 

 
2. To create the path click the “Linear” button or select the command in the “Curve” 

menu.  

Linear 
 
3. Next select the “Center Circle” pick mode and move the cursor to the position as 

shown in Picture 2-37 in order to define the center coordinates. The geometry pre-
view will help you as it automatically snaps to the center when moving the cursor on 
the existing circle. Click the mouse to select the position. The finished path is dis-
played in form of a small triangle as shown in Picture 2-38. 

Center Arc / Circle 
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Z X

 Cursor Position to select Drilling Location

 
 

Picture 2-37 
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 Completed "Drill12" Curve

 
 

Picture 2-38 
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CREATING THE PART PROGRAM 
Now as the curves for the sample part are created we continue with the definition of the 
Work Steps that are necessary to machine the part. Every Work Step is created by select-
ing a cycle (Contour, Pocket, Drilling, etc.), specifying associated tool settings / machin-
ing parameters and assigning a curve that will be machined. Verifying the calculated tool 
path assures correct tool operation. Finally, when all necessary Work Steps have been 
defined the complete part program can again be visually checked using the 3D solid sim-
ulation. If everything works fine you can continue to the next step and create the CNC-
Code. 
 
 

   
Execution of the Work Steps will be in the same order they have 
been created. You can use the integrated spreadsheet to perform 
operations such as moving, reordering or deleting existing Work 
Steps. 
 
See the “Spreadsheet” book in the online help for more detailed 
information. 

 
 
The Part Program section of the EZ-Mill tutorial contains all Work Steps that are neces-
sary to machine the part. 
 
 
The part program of the tutorial will consist of these 8 Work Steps: 
 
1. Zig-Zag “Face” machining to rough machine the outside profile leaving 0.2mm 

stock allowance for finishing. 

2. “Pocket” machining of curve “Pocket1”leaving 0.2mm stock allowance for finishing. 

3. “Pocket” machining of curve “Pocket2” leaving 0.2mm stock allowance for finish-
ing. 

4. Finishing (“Contouring”) the outside profile 

5. Finishing (“Contouring”) Pocket1 (circular pocket) 

6. Finishing (“Contouring”) Pocket2 

7. Spot-Drill 12mm DIA hole 

8. Drill 12mm DIA hole 
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CREATING WORK STEP #1  (ROUGHING OUTSIDE PROFILE) 
Now we create the first Work Step for rough machining the exterior profile using the 
“Zig-Zag” cycle. The result will be a pocketing type of machining using the rectangular 
geometry as the pocket boundary and the parts shape as an island. The tool moves extend 
over the specified boundary to clean up any remaining material. We will use a 14mm 
DIA end mill for machining up to the depth of 15mm, stepping down in increments of 
5mm and leaving 0.2mm as finishing offset on the parts outside profile. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 

 
 
2. Press the “New” button and input “Face” as the new Work Step ID and confirm with 

OK. 

 

 
 
3. Select “Zig-Zag” from the cycle list and the “Boundary” curve from the Path ID list. 

 
 



EZ-MILL 2D TUTORIAL 

EZ-CAM 2-47 

 
4. Input tool and technology settings to the appropriate fields as shown in Picture 2-39. 

 

 
 

Picture 2-39 
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5. Select the “Cycle Data” tab and make sure that the “Finish Pass”, “Face Milling”, 
“Minimize Jumps” and “Climb Milling” options are checked. . Input “0.2” to the 
“Stock Allow” field. This will result in 0.2 mm of material left on the contour to be 
removed later by the finishing Work Step. Input “5” as “Step Over” value for the 
“Zig-Zag” cycle. See Picture 2-40. 
 

 
 

Picture 2-40 
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6. By the previous selection of the “Boundary” curve in the “Path ID” list, we only 
specified the outer border for the “Zig-Zag” cycle. As already mentioned one way to 
define islands is to directly append them at the end of the boundary curve. For this 
tutorial we will apply the second method by putting the “ODContour” curve to the 
“Check Curves” list. Therefore select the “3D Cycle Data” tab and press the “Add” 
button in the “Check Curves” section. On the dialog that opens select the “ODCon-
tour” curve from the list and continue pressing the “Add” button. Also note the “Fin 
Allow” automatically set to the same value as “Stock Allow” from the previous “Cy-
cle Data” tab. Finally close the Work Step Data dialog using the “Close” button. See 
Picture 2-41. 

 

 

 
 

Picture 2-41 
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7. To ensure that the first Work Step was created correctly, it must be verified. Switch 
to “X-Y View” using the command button. Then click the “Verify” button. The sys-
tem calculates the cutter path as shown in Picture 2-42. 

 

X-Y View Verify 
 
 
 

 
 

Picture 2-42 
 
 

The first Work Step is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #2  (ROUGHING CIRCULAR POCKET) 
Next step is roughing the 30mm DIA circular pocket. We use the “Pocket“ cycle with the 
same tool and machining settings as in the previous Work Step, leaving 0.2mm as finish-
ing offset on the pocket profile. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
2. Press the “New” button and input “RG-Pocket1” as the new Work Step ID and con-

firm with OK (“RG” as shortcut for “Rough”).  

 

 
 
3. Select “Pocketing” from the cycle list and the “Pocket1” curve from the Path ID list. 

 
 

 
 
 
4. As tool and depth data remains the same we only need to set the “Feed (Z)” to a 

somewhat smaller value of “50”mm per minute since there is no pre-drilling and the 
tool is plunging directly into the pocket. 

 
5. Switch to the “Cycle Data” tab and check that  “0.2” as “Stock Allow” and “5” as 

“Step Over” value are set (should be ok from previous work Step). See Picture 2-43. 
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Picture 2-43 
 
6. For Verification click the “Verify” button. The system calculates the tool path. Then 

you may use the “Simulate Tool” command to get a more realistic simulation of the 
tool movement as shown in Picture 2-44. 

Verify Simulate Tool 
 

Y

Z X

 
 

Picture 2-44 
 
 

The second Work Step is now complete. Hit the “Redraw” button   to refresh 
the screen and remove the verified tool path display. 
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CREATING WORK STEP #3  (ROUGHING INSIDE POCKETS) 
Next step is roughing the two inside pockets. We use the “Pocketing“ cycle with a 10mm 
DIA end mill to machine the pockets up to the depth of 5mm in one step leaving 0.2mm 
as finishing offset on the pocket profile. Both pocket boundaries have already been de-
fined in the same curve reducing input and Work Step management because they are ma-
chined using identical parameters and settings. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
2. Press the “New” button and input “RG-Pocket2” as the new Work Step ID and con-

firm with OK.  

 

 
 
3. Select “Pocketing” from the cycle list and the “Pocket2” curve from the Path ID list. 

 
 

 
 
 
4. Input new tool and technology settings in the appropriate fields as shown in Picture 

2-45.  
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Picture 2-45 
 
5. Switch to the “Cycle Data” tab and check that  “0.2” as “Stock Allow” and “5” as 

“Step Over” value are set (should be ok from previous work Step). 

 
6. For Verification click the “Verify” button. The system calculates the tool path. Then 

use the “Simulate Tool” command to get a more realistic simulation of the tool 
movement as shown in Picture 2-46. 

Verify Simulate Tool 
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Picture 2-46 
 
 
 

The third Work Step is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #4  (FINISHING OUTSIDE PROFILE) 
This Work Step will finish the outside profile in clockwise direction using a 10mm DIA 
end mill. We also use the automatic Ramp/Lead options that will calculate Ramp and 
Lead moves at beginning and end of the profile. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
2. Press the “New” button and input “FN-Outside” as the new Work Step ID and con-

firm with OK.  

 

 
 
3. Select “Contouring” from the cycle list and the “ODContour” curve from the Path ID 

list. 

 

 
 
 
4. Input following tool and technology settings in the appropriate fields located in the 

“Tool Info” tab. 

 
  Tool Number  : 3  
  Diameter (Top) : 10  
  Spindle RPM  : 1500  
  Feed (X-Y)   : 300 
  Feed (Z)   : 250 
  ZDepth  : 15 
 Zstep   : 0 
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5. Select the “Cycle Data” tab and input new cycle specific settings as shown in Pic-
ture 2-47. This includes the correct “Offset Dir” set to left, “Stock Allow” now “0” 
and combined Ramp and Lead options. 

 
 

Picture 2-47 
 
6. For Verification click the “Verify” button. The system calculates the tool path. Then 

use the “Simulate Tool” command to get a realistic simulation of the tool movement. 
See Picture 2-48. 

Verify Simulate Tool 
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Picture 2-48 
 
 
 

The Work Step #4 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 

 
 
 

   
If the verified tool path is on the wrong side of the profile open 
the “Work Step Data” dialog. Select the “Cycle Data” tab and 
make sure that the “Work Step ID” list shows the name of the 
Work Step you are currently working on. Check that the “Offset 
Dir” parameter is set to “Left”. If that is already the case, then the 
path was chained in counter clockwise direction. To change path 
direction click the “Reverse Dir” checkbox on the same page. Be 
aware that the “Reverse Dir” option only reverses the calculated 
tool path without touching the original curve. As an alternative 
you may select the “Reverse Direction” command located in the 
“Curves” menu.  This command reverses the direction of the cur-
rent curve. 
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CREATING WORK STEP #5  (FINISHING CIRLUAR POCKET) 
This Work Step will use the same cycle (“Contour”), tool and machining parameters as 
the previous one. Therefore it is a good example to demonstrate how to copy a complete 
Work Step by using the integrated spreadsheet. Once copied, we only have to assign a 
different path curve. 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the “Ma-

chining” menu. Another way to make the spreadsheet visible or to resize it without 
selecting a menu command is to use the cursor. 

 
 
Place your cursor just above the screen prompt. 

  
 

 
 
 

When the mouse pointer changes to  , drag it up to the position you want. 
 
 

 
 
 

The spreadsheet is like a window shade. Pull it up when you need it and pull it down 
when you don't. 
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2. To select the complete Work Step to be copied, click the cursor in the first cell as 
shown in Picture 2-49.  

 

 
 

Picture 2-49 
 
 
3. The next step is to copy the Work Step to the clipboard. You can activate the spread-

sheet menu by selecting the yellow arrow or right-click on the mouse. Either way, 
once you have activated the menu, select the “Copy Work Step” command. See Pic-
ture 2-50. 

 

 
 

Picture 2-50 
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4. Now that Work Step “FN-Outside” has been copied to the clipboard, the next step is 

to select the position where you want the Work Step to be pasted back into the 
spreadsheet. Remember, the “Paste Work Step” command always inserts the Work 
Step above the active cell or row in the spreadsheet. As we want the copied Work 
Step to be inserted at the end, click anywhere within the “Total” row to make this the 
active row. See Picture 2-51. 

 

 
 

Picture 2-51 
 
5. Activate the spreadsheet menu by clicking the yellow arrow or by right-clicking the 

mouse. Click on the “Paste Work Step” command as shown in Picture 2-52. Picture 
2-53 shows the copied Work Step named “2xFN-Outside”, “2x” indicating that it 
was copied from “FN-Outside”. 

 

 
 

Picture 2-52 
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Picture 2-53 
 
 

   
A similar method is used to reorder Work Steps. The only differ-
ence is to use the “Cut Work Step” command instead of “Copy 
Work Step”. This will remove the Work Step from the spreadsheet 
and copy the data to the Clipboard. Then select the position where 
you want the Work Step to be pasted back and select the “Paste 
Work Step” command. 

 
 
6. As can be seen in Picture 2-53 the Work Step ID is automatically named “2xFN-

Outside”. To rename the Work Step directly select the “Wk Step ID” field with the 
cursor, type the new name “FN-Pocket1” and press ENTER button. For the result see 
Picture 2-54. 

 

 
 

Picture 2-54 
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7. As we copied the whole Work Step there is still the “ODContour” curve associated 

to the new copy. To assign the correct pocket curve use the cursor to select the corre-
sponding field in the “Path ID” column. Select the “Pocket1” curve from the list that 
opens when pressing the small arrow button. See Picture 2-55. 

 

 
 

Picture 2-55 
 
8. For Verification click the “Verify” button. The system calculates the tool path. Use 

the “Simulate Tool” command to get a realistic simulation of the tool movement. See 
Picture 2-56. 

Verify Simulate Tool 
 

Y

Z X

 
 

Picture 2-56 
 

The Work Step #5 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #6  (FINISHING INSIDE POCKETS) 
This Work Step finishes the two remaining pockets up to the depth of 5mm. Like we did 
in the previous step we will use the spreadsheet to copy and paste “FN-Pocket1” Work 
Step to save time, as most of the tool parameters and settings for the new Work Step will 
be identical. For a more detailed explanation on how to copy and paste Work Step’s in 
the spreadsheet see the previous Topic (Work Step #5). 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the “Ma-

chining” menu or use the cursor. 

 

2. Select “FN-Pocket1” as the Work Step to be copied. Right-click to open the menu 
and click the “Copy Work Step” command. 

 

3. Click somewhere in the “Total” line because the “Paste Work Step” command al-
ways pastes the Work Step above the active cell or row in the spreadsheet. Right-
click to open the menu and click the “Paste Work Step” command. Picture 2-57 
shows the copied Work Step named “2xFN-Pocket1”. 

 

 
 

Picture 2-57 
 
 
4. As in the previous Work Step we will also rename the ID of the copied Work Step. 

Therefore select the “Wk Step ID” field with the cursor and type the new name “FN-
Pocket2” and press ENTER button. 

 



EZ-MILL 2D TUTORIAL 

EZ-CAM 2-65 

 
5. To change the depth setting of the new Work Step select the appropriate cell in the 

“ZDepth” column with the mouse and input “5” as the new depth. See Picture 2-58. 

 

 
 

Picture 2-58 
 
6. To change the already assigned path curve use the cursor to select the corresponding 

field in the “Path ID” column. Select the “Pocket2” curve from the list that opens 
when pressing the small arrow button. See Picture 2-59. 

 

 
 

Picture 2-59 
 
8. For Verification click the “Verify” button. The system calculates the tool path. Use 

the “Simulate Tool” command to get a more realistic simulation of the tool move-
ment as shown in Picture 2-61. 

Verify Simulate Tool 
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Y

Z X

 

 
 

Picture 2-61 
 
 
 

The Work Step #6 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #7  (SPOT-DRILLING 12MM HOLE) 
After completion of the milling operations we continue with spot-drilling the12mm DIA 
hole using the standard “Drilling“ cycle 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
2. Press the “New” button and input “Spot-Dia12” as the new Work Step ID and con-

firm with OK.  

 

 
 
3. Select “Drill” from the cycle list and the “Drill12” curve from the Path ID list. 

 
 

 
 
 
4. Input following tool and technology settings in the appropriate fields located in the 

“Tool Info” tab. 

 
  Tool Number  : 4  
  Diameter (Top) : 10  
  Spindle RPM  : 1600  
  Feed (Z)   : 120 
  ZDepth  : 3 
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5. To calculate the tool path click the “Verify” button. Then use the “Simulate Tool” 

command to get a more realistic simulation of the tool movement as shown in Pic-
ture 2-62. 

Verify Simulate Tool 
 
 

Y

Z X

 
 

Picture 2-62 
 
 
 

The Work Step #7 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #8  (DRILLING 12MM HOLE) 
This Work Step finishes the part by drilling the 12mm DIA hole. We will copy and paste 
the existing “Spot-Dia12” Work Step and edit cycle, tool and machining parameters us-
ing the spreadsheet. There is no need to assign a different path curve since it is the same 
as the one that was already copied from the “Spot-Dia12” Work Step. 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the 

“Work Step” menu or use the cursor. 

 

2. Select “Spot-Dia12” as the Work Step to be copied. Right-click to open the menu 
and click the “Copy Work Step” command. 

 

3. Click somewhere in the “Total” line because the “Paste Work Step” command al-
ways pastes the Work Step above the active cell or row in the spreadsheet. Right-
click to open the menu and click the “Paste Work Step” command. Picture 2-63 
shows the copied Work Step named “2xHoles1”. 

 
 

 
 

Picture 2-63 
 
 
4. As in the previous Work Step we will also rename the ID of the copied Work Step. 

Therefore select the “Wk Step ID” field with the cursor and type the new name 
“Drill-Dia12” and press ENTER button. Move the cursor to the Cycle Type” field 
and select the “Chip Break” cycle. See Picture 2-64. 
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Picture 2-64 
 
 
5. Use the      arrow keys to navigate through the cells of the “Drill-Dia12” Work 

Step and assign the settings listed below. The result should appear as in Picture 2-
65. 
 

  Tool Number  : 5  
  Diameter (“Dia”) : 12  
  Spindle Speed (RPM) : 1200  
  Feed Rate (“Fd Z”)  : 80 
  Depth (“ZDepth”)  : 21  
  Step (“ZStep”) : 3 

 
 

 
 

Picture 2-65 
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6. To calculate the tool path click the “Verify” button. Then use the “Simulate Tool” 

command to get a more realistic simulation of the tool movement as shown in Pic-
ture 2-66. 

Verify Simulate Tool 
 
 

Y

Z X

 
 

Picture 2-66 
 
 
 

The Work Step #8 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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ESTIMATING TOTAL MACHINING TIME 
The “Verify All” command in the “Post” menu is used to estimate the total machining 
time. It performs an on-screen verification of all Work Steps in memory, in the machin-
ing order. The total machining time (not including rapid traverse or tool change time) is 
displayed in a dialog box at the end of the verification process. To close the dialog click 
OK. To get the same view as shown in Picture 2-67, switch to isometric using the “View 
Isometric” command and select “Verify All” to start tool path calculation. 
 

 
View Iso-
metric 

Verify All 

 

 
 

Picture 2-67 
 
 
 

  
 

It is very important for the “3D Preview” simulation in the next 
section to have toolpaths of all work steps verified completely. If 
you previously interrupted any computation during “Verify” by 
hitting “Escape”, or have started a new session and loaded your 
previously saved work, you must first “Verify All” work steps. 
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3D SOLID PREVIEW 
One of the most powerful EZ-CAM features is the 3D solid preview function. This func-
tion shows an animated tool cutting a solid model of the programmed part. Once the sim-
ulation is finished or interrupted by the user pressing “Esc” key, all dynamic view com-
mands to rotate, zoom or move the simulated model on the screen are available. If no 
“Stock Setup” has been defined when the “Preview 3D” command is called, the system 
automatically calculates the “Stock” size, according to the maximum calculated tool 
movements. For the tutorial we will manually assign the stock size using the “Stock Set-
up” dialog that can be opened from the “Machining” menu. 
 
 
1. Select the “Stock Setup” command from the “Machining” menu and input the values 

as shown in Picture 2-68. Close the dialog with OK. 

 

 
 

Picture 2-68 
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2. Before starting the preview select the “Isometric View” command. Then start the 

simulation using “Preview 3D” command from the “Machining” menu or the corre-
sponding button. See Picture 2-69.  

View Iso-
metric 

Preview 3D 

 

 

 
 

Picture 2-69 
 
 

3. Once the simulation stopped you can change the on-screen view by using the dynam-
ic view commands (Rotate, Pan, Zoom) from the “View / Dynamic Viewing” menu. 

Dynamic Rotate Dynamic Zoom Dynamic Pan
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SAVING THE PART 
It is very important to save the newly created or edited part from memory to disk periodi-
cally during a session as well as at the end to ensure that no information is lost. The EZ-
CAM “Save” and “Save as” commands under the File menu transfer files from system 
memory to a hard disk or other media. In EZ-MILL, the part information is stored in two 
different types of files, the “Part” file using the extension "3DP" and the associated “Ge-
ometry” file with extension "GEO". This flexibility allows the user to load an existing 
part file to be used with newly created geometry and path curves. 
 
File Type  : GEOMETRY 
Extension : GEO 
Data  : Geometry Elements (lines, arcs, etc.), Curves, 

  User Coordinate Systems (UCS) 
 
File Type  : PART Files 
Extension : 3DP 
Data     : Work Step Data (Technology & Machining Information) 
 
There is no specific rule what should be saved first. Of course, if there is only one kind of 
data in memory (Work Steps or Geometry) the “Save as” dialog will automatically be set 
to the correct file type. 
 
 

 
 

Picture 2-70 
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1. Select “Save as” command from the “File” menu. 

 

2. Select the appropriate drive and folder where the geometry and part files should be 
stored. You can use the “EZCAMW \ MILLPARTS” folder that was automatically 
created by the setup routine. 

 

3. Select “Geometry (*.GEO)” from the “Save as type” list box to store the geometry 
data. 

 

4. Type the new filename “Mill-Tutorial” in the File Name box and click the “Save” 
button. The file extension is added automatically.  

 

5. To store the machining information (Work Step Data) select “Part Files (*.3DP)” 
from the “Save as type” list box and click “Save” again. 

 
 

   
If you have already saved the geometry, the software automatical-
ly inserts a part file with the same name but different extension 
(*.3DP) in the “Save” menu when the first Work Step is created. 
All you have to do is to select “Save All” option from the “File” 
menu or the corresponding toolbar button. 
 

 
 
Save 
All 

 

 
 
 
 
 

 

The software will save and overwrite the existing files without 
any screen prompt. You can use this command anytime for fast 
saving of your work. 
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It is not possible to save data when the software is running in 
evaluation mode. The “Save”, “Save as” and “Print” commands 
are disabled. 

 
 

CREATING CNC CODE 
Now that the part program has been created, it must be converted to run on a NC control 
by running the “Post” command with the appropriate “Post-Processor” for your machine. 
 

   
 

The CNC data file or “Post-Processor” is used as a "template" to 
format the part program data file that was created in EZ-Mill. This 
template consists of program formats (e.g., TOOL CHANGE, 
LINEAR MOVE, RAPID MOVE, etc.) that determine the struc-
ture of a part program for a specific CNC. To create or edit a 
“Post-Processor” a special editor called “MBuild” is required.  

 
1. Select “Post” command in the “Machining” menu to open the “Post Process” dialog. 

 

 
 

Picture 2-71 
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2. First you need to select the postprocessor. If the one desired is already loaded and 

displayed in the section “CNC-File”, continue to the next step. Otherwise use the 
“Change” button to browse your system for a different one. For this tutorial you may 
use the “FAN-DEMO.CNC” post (standard metric post that creates Fanuc style 
code). 

 

   
 

Standard postprocessor folders created by the EZ-CAM v15 setup: 
 
INCH 
<DRIVE>: \ EZCAMW \ EZCAM15 \ MILLINCHPOST 
 
METRIC 
<DRIVE>: \ EZCAMW \ EZCAM15 \ MILLMETRICPOST 

 
3. Select the “G-Code” option from the “Listings” list box. The computed program text 

will be displayed on the screen. 

 

4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” 
application when posting of the part file is finished and load the newly created file 
for sending it to the machine using the serial port. See Chapter 6 “Communication 
with the Control” for more information about EZ-DNC. 

 

5. Next is the “G-Code File” section. Here the default name and directory for the com-
puted program file is displayed. The name is taken from the part file that was saved 
before. The default directory is “EZCAMW\MILLGCODE”. 

 

   
 

Ensure that part file and postprocessor share the same dimension 
unit (“Metric” for this tutorial). The system will generate a “Di-
mension Unit Conflict” message, but then automatically scale the 
NC-Code according to the dimension specified in the postproces-
sor.  
See online help for more information about the “Setup” dialog 
located in the “View” menu. 

 

6. Click the “Post” to start posting. The Processing window will be displayed showing 
messages followed by listings of ASCII code created. When all Work Steps have 
been processed, a final message dialog box is shown. See Picture 2-72. 
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Picture 2-72 
 
 
7. Click OK to close the message dialog box. To close the Processing window 

click  at the top right-hand corner of the window. 

 
 
 

Congratulations! 
 

You've completed the EZ-MILL 2D Tutorial !
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OVERVIEW 
This tutorial is intended to present to you the 3D Machining Wizard, which makes 3D 
part programming easier than the regular Work Step Data window. The 3D Machining 
Wizard collects information about the most important machining parameters from the 
user, in a brief window, avoiding confusing settings. Some parameters are pre-defined to 
the most appropriate values for the current machining method; however, the user always 
has the option to alter them as to his needs. 
 
The solid model can be imported into EZ-MILL Pro in several file formats, like sldprt, 
igs, step, sat, x_t or x_b. Beginning from version 19, SolidWorks users can transfer the 
3D model directly from the SolidWorks working window to EZ-CAM in one click. The 
3D Machining Wizard automatically detects and assigns all the surfaces to the recently 
created Work Step; however, the user can choose to deselect any of them. 
 

Throughout the tutorial you will find important notes  , tips   or references to the 
online help where additional information on the commands and functions is provided. 
 
 

CAVITY MACHINING 
In this tutorial we will machine a detergent bottle mold. It is a cavity of a bottle divided 
from the centerline. It has a boss corresponding to the handle portion, which creates an 
island in the middle of the cavity. The mold cavity has both steep and flat sections which 
we need to consider at the finishing stage. Surface transitions have fillets in several di-
mensions. 
 
The first operation will be roughing with a large tool to get rid of the bulk material inside 
the cavity. Secondly we will apply a re-roughing workstep to machine the uncut material 
with a relatively small tool. The finishing operation will be carried out by a 3D Equidis-
tant machining method providing even surface roughness throughout the mold. Finally 
we will introduce a re-finishing technique and cut the remaining material left by the rela-
tively lager tool of the previous finishing operation. 
 

CHAPTER 3.  
EZ-MILL PRO / 3D TUTORIAL 
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BASIC PROGRAMMING STEPS 
Before we continue with the tutorial let us explain the basic steps needed to create the 
part program. 
 
 
STEP 1.  Load (Import) the 3D Solid Model of the Part to be machined 

For our sample part we will use a 3D model created in Rhino and saved 
in ACIS format “sat”. Other common CAD translation formats can also 
be used to import external data to EZ-Mill Pro, such as igs, 3dm, step, 
x_t, x_b, etc. SolidWorks users can directly transfer the solid model to 
the EZ-CAM window using the “Update Solidworks Model” command. 

 
 
STEP 2.  Define World/UCS origin on the 3D Solid Model 

We will change the World/UCS origin point to a reference location on 
the real part stock. 

 
 
STEP 3.  Create Work Steps and set all Machining Parameters 

We will create machining work steps, specify tool and operation pa-
rameters, create path Curves (if required), and verify the toolpaths. Al-
so we will create rough and re-rough surface milling operations, leav-
ing stock on all surfaces then finish and re-finish surface milling opera-
tions; removing the remaining material, leaving minimal cusps. 

 
 
STEP 4.  Check Material Removal and Surface Finish 

We will check to make sure all material is removed and the surface fin-
ish smoothness is acceptable. 

 
 

  

The EZ-MILL Pro 3D Machining Wizard Tutorial is set up in Inch 
with all Inputs and Dimensions in Inch ! 
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THE PART 
Below is the image of the sample part we will machine in this tutorial. It is a detergent 
bottle mold with an approximate size of 13.5”x11.5”. The cavity of the mold has steep 
walls near the top surface, and a boss with steep walls corresponding to the handle of the 
bottle. There are fillets with radii changing between .079” and .2” in surface transition 
sections.  
 
 
 

 
 
 

Picture 3-1 
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SETTING THE PREFERENCES 
Let’s first set some important parameters such as units and other viewing preferences to 
ensure the compatibility of your system with the tutorial.  
 
1. Select the ”New” command from the “File” menu to restart EZ-Mill Pro and to clear 

the memory before continuing with the tutorial. Make sure the “EZ-Mill Pro” level is 
active and press OK to start over. 

 

 
 
 

  
 

The “New” dialog is also used to switch between the EZ-Mill and 
EZ-Turn modules. Before the dialog opens the system checks the 
software protection key for activated modules. Modules or levels 
that are not activated will be marked by appended “DEMO” text. 
When working in “Demo” (evaluation) mode, it is not possible to 
print or save data. The corresponding “Save”, “Save as” and 
“Print” commands are disabled. 
 
When closing the EZCAM application, the system automatically 
stores the last used level as default for the next session. 

 
2. Select the ”Setup” command from the “View” menu 

 

3. Select the “Inch” option button as the input dimension system. 

 

4. Click the “Background” list box and select “White”. 

 

5. Click the “Show Toolpath” list box and select "Blank Verify”. This will cause veri-
fied tool paths to be blanked when the screen is redrawn. 
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6. Click the “Show Direction” list box and select "None". This will hide the small ar-
rows indicating the surface normals and curve directions. It can later be activated at 
any time. 

 

7. Check "Save as Default". The system will store all dialog settings as defaults for 
future sessions. 

 

8. After the preferences have been correctly set, click OK. 

 

 
 

Picture 3-2 
 
 
The initial setup for the EZ-MILL Pro 3D Machining Wizard Tutorial is now complete. 
Continue with the next section to create the geometry necessary for this part. 
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LOADING THE SOLID PART 
We will begin the exercise by loading the surface geometry that represents our part. 
There are several methods to accomplish this process. The first method is to import a 
solid/surface type of model into EZ-CAM in one of the common CAD file formats, such 
as iges, sat, step, sldprt, sldasm, x_t, x_b, dwg, vda or 3dm. Secondly, you can open the 
model in our companion CAD product, Rhino, then copy/paste to EZ-Mill using the spe-
cial command “Paste from Rhino” found under the “Edit” menu. The last method is for 
SolidWorks users; they can load the model into SolidWorks and transfer the file to EZ-
CAM by using the new “Update Solidworks Model” command. In this tutorial we choose 
the first method and load a SAT file representing the 3D model. 
 

  

You may refer to “EZ-Mill 3D Machining Solids Tutorial” to get 
information about “Copy and Pasting the Model from Rhino” 

 
The “SAT” file containing the 3D model has already been copied into the “EZ-
CAMW\MILLPARTS” folder by the EZ-CAM setup. Follow the steps below to load the 
data. 
 

 
 

Picture 3-3 
 
 
1. Select the “Open” command from the “File” menu to open the file dialog. In Picture 

3-3 you can see the dialog displayed on a Windows Vista workstation system. This 
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dialog may vary according to the version of the Windows operating system run-
ning on your machine. 

 

2. Select the folder “EZCAMW \ MILLPARTS” on the drive where you installed the 
software 

 

3. In the “Files of Type” list select “ACIS Solid Models (*.sat)”. 

 

4. Select the file “Detergent Bottle Mold-inch.sat” and click the “Open” button. The 
imported surface geometry should then appear as shown in Picture 3-4. 

 
 
 

 
 

Picture 3-4 
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DEFINING WORLD/UCS ORIGIN OF THE PART 
We will define the part origin point as the zero position that will be assigned to the stock 
before machining on the CNC machine. In this tutorial the front left corner of the part 
block will be selected as the origin point--using the default coordinate system “World”. 
The top plane of the part will be designated as Z=0 position. 
 
 
1. To define the new “World” origin point, select the “World/UCS, Three Points” 

command from the “View” menu or click the corresponding button. 

World/UCS, Three Points
 
2. Select the “Snap All” command from the “Edit > Point Picking” menu or click the 

corresponding button.  

Snap All 
 
3. Click the corner points 1, 2 and 3 on the part; See Picture 3-5. These points desig-

nate new origin point, X-axis direction and Y-axis direction respectively. 

 

 
 

Picture 3-5 
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4. The part will be oriented as to the new position of “World” coordinate system that is 
appropriate for machining as shown in Picture 3-6. 

 
 

 
 

Picture 3-6 
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CREATING THE PART PROGRAM 
Now that we have completed setting the origin point of the part we are ready to begin 
defining the work steps to machine it. Each work step uses a specific method (Roughing, 
Finishing, etc.) and a Toolpath Type (Pocketing, Parallel, etc.) along with its associated 
tool settings and parameters to create a toolpath that machines the assigned curves and 
surfaces. Our part program will consist of the following work steps. 
 
 

Work Step ID Purpose 

Roughing 

Rough the cavity leaving a stock allowance of .005” with a .625” 
flat tool. We will use a Pocketing toolpath pattern generated with-
in the boundaries of each surface slice computed using a  
Z-step value of .04”. 

Re-Roughing 
 

Machine the uncut material sections where the previous tool of 
the Roughing operation could not fit. The system will automatical-
ly detect each uncut boundary and create an auxiliary curve. A 
pocketing type of toolpath will be used with a relatively smaller 
flat tool with a diameter of .1875”. 

Finishing 
 

Finish the cavity surfaces, limited by the curves defining the outer 
and inner boundaries. The 3D Equidistant type of toolpath will 
generate evenly distributed toolpath passes all around the fin-
ished surfaces. A ball nose tool with a diameter of .375” will be 
used. 

Re-Finishing 

Re-Finish the rest material remaining from the Finishing opera-
tion, using a relatively smaller ball nose tool with a diameter of 
.125”. The system will automatically detect the sections that have 
smaller indentation and concavity than the Finishing tool can cut 
and generate a 3D toolpath around them. 
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CREATING WORK STEP “1_ROUGHING” 
The first work step will machine the bulk material inside the cavity in order to prepare it 
for the finishing operation. We will use the “3D Machining Wizard” for defining the ma-
chining parameters. The wizard automatically selects all the visible surfaces as “cut sur-
faces” and sets the “surface” parameter in the Z Data section to the highest Z point of the 
surfaces. Besides it sets several parameters to the most appropriate values for the active 
operation. We will not specify any boundary curves for the roughing operation and let the 
system detect the outer boundary (silhouette) of the cut surfaces. 
 
1. Select the “3D Machining Wizard” command in the “Machining” menu or click the 

corresponding button. 

3D Machining Wizard 
 
2. Input “1_ROUGHING” as the new Work Step ID. Confirm with OK. 

 
 
3. Select “ROUGHING” from the Method list box. 

 

 
 
 
4. Select “Pocketing” from the Toolpath Type list box. Until a toolpath type is selected 

all other input boxes appear as disabled. 
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5. On the “3D Machining Wizard” window, change the settings according to the table 
below and ensure that all parameters are set as shown in Picture 3-7. 

 

Dialog Field Value Comment 

Type Flat Flat type endmill 

Number 1 Tool number in tool magazine 

Diameter (Bot.) 0.625 Defines the diameter of the tool  

Spindle RPM 750 Sets spindle RPM to 750 

Feed (X-Y) 50 Cutting feed rate in XY plane (inches/minute) 

Feed (Z) 5 Cutting feed rate for Z depth moves 

Surface 0 
Set our Z surface to the top of the block. This 
value is automatically detected by the system 
as the top point of the solid body. 

Rapid 0.5 Rapid positioning plane over “Z Surface” plane 
during transversal rapid moves 

Clear 0.05 
Plunge plane over “Z Surface” plane (Rapid to 
Feedrate) 

Step-Z 0.04 Incremental depth per Z-level pass 

Fin Allow 0.005 
Finishing allowance value. Material that re-
mains along the surfaces to be removed later 
with the finishing operation 

Step Over 50% 

The distance between the tool passes on the 
machining plane. The value is given as the 
percentage of the tool diameter. (you may opt 
to use an absolute value instead) 
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Picture 3-7 
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6. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-8. 

Verify 

 
 

Picture 3-8 
 
 
 

The Work Step #1 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP “2_RE-ROUGHING” 
The second machining work step will remove material only in the sections where the 
roughing tool could not fit. We will use a tool with a relatively smaller diameter. 
EZ-CAM system will detect the uncut boundaries at every roughing slice of the reference 
Work Step, and create an auxiliary curve that will be machined according to the selected 
re-roughing toolpath type. 
 
1. Select the “3D Machining Wizard” command in the “Machining” menu or click the 

corresponding button. 

3D Machining Wizard 
 
2. Input “2_RE-ROUGHING” as the new Work Step ID. Confirm with OK. 

 
 
3. Select “RE-ROUGHING” from the Method list box. 

 
4. Select “Pocketing” from the Toolpath Type list box. 

 

 
 
 
5. Select “1_ROUGHING” from the Ref.Work Step list box. 
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6. On the “3D Machining Wizard” window, change the settings according to the table 
below and ensure that all parameters are set as shown in Picture 3-9. 

 

Dialog Field Value Comment 

Type Flat Flat type endmill 

Number 2 Tool number in tool magazine 

Diameter (Bot.) 0.1875 Defines the diameter of the tool  

Spindle RPM 2000 Sets spindle RPM to 2000 

Feed (X-Y) 15 Cutting feed rate in XY plane (inches/minute) 

Feed (Z) 5 Cutting feed rate for Z depth moves 

Surface 0 
Set our Z surface to the top of the block. This 
value is automatically detected by the system 
as the top point of the solid body. 

Rapid 0.5 Rapid positioning plane over “Z Surface” plane 
during transversal rapid moves 

Clear 0.05 
Plunge plane over “Z Surface” plane (Rapid to 
Feedrate) 

Step-Z 0.04 

Incremental depth per Z-level pass is automat-
ically set to the same value as the reference 
work step, however can be reduced to a lower 
value in order to decrease the tool load 

Step Over 50% 

The distance between the tool passes on the 
machining plane. The value is given as the 
percentage of the tool diameter. (you may opt 
to use a decimal value instead) 
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Picture 3-9 
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7. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-10. 

Verify 

 
 

Picture 3-10 
 
 
 
8. An auxiliary curve in yellow representing the machining area around the uncut sec-

tions appears after generating the toolpath. In order to hide it, select the “Blank” 
command from the “Edit” menu or click the corresponding button.  

Blank 
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9. Select the curve “1_ROUGHING-rest” in the object list box. The yellow uncut 
boundary curve and the toolpath disappear. 

 

 
 
 

10. Click the “Escape” button in the toolbar or hit “Esc” button on the keyboard to abort 
Blank command and to prevent accidental selection of an object on the screen.  

Escape 
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DEFINING THE BOUNDARY CURVES FOR FINISHING OPERATION 
We need to create curves to define machining borders for our finishing operation by us-
ing the solid model representation of the 3D part. We have few choices  for curve crea-
tion from the 3D model such as “Face Boundary”, “X-Y Intersection” or “Silhouette 
Boundary” commands. Here we use Face Boundary command to create the outer bounda-
ry of the mold cavity and inner boundary from the flat surface around the handle section. 
 
 
1. To create the outer finishing boundary curve choose the “Face Boundary” command 

from the “Curves“ menu, type “outer” as the Curve ID and click OK. 

 
Face Boundary 

  
 
2. Select the “Verify Mode” command in the “Edit” menu or click the corresponding 

button. This mode displays the selected object in different color and waits for our 
confirmation allowing us to abort the process or continue selecting multiple objects. 

Verify Mode 
 
 
3. Now we should select the surface on the part from which the face boundary curve 

will be created. Click anywhere on the outermost top surface. After clicking, the col-
or of the surface changes to inform you that it’s selected. See Picture 3-11. 
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Picture 3-11 
 
 

4. Click the “Enter” button in the toolbar or hit “ENTER” button on the keyboard to 
confirm. See Picture 3-12.  

Enter 
 

 

 
 
 

Picture 3-12 
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5. We only need the curve created at the intersection of the top plane and the cavity. So 
it is better to delete the outermost one to prevent confusion. Select the “Delete” 
command from the “Edit” menu or click the corresponding button. Then select the 
“Curve…” command from the “Edit > Discrimination” menu or click the corre-
sponding button. 

 
Delete Discrim. Curves 

 
 
6. Click the blue curve on the outer edge of the part and hit ENTER. See Picture 3-13. 

 

 
 

Picture 3-13 
 

 
 
7. For creating the inner finishing boundary curve choose the “Face Boundary” com-

mand from the “Curves“ menu, type “inner” as the Curve ID and click OK. 

 
Face Boundary 
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8. Click the planar surface on top of the boss in the cavity corresponding to the handle 
of the bottle. After clicking, the color of the surface changes to inform you that it’s 
selected. See Picture 3-14. 

 

 
 

Picture 3-14 
 
 

9. Click the “Enter” button in the toolbar or hit “ENTER” button on the keyboard to 
confirm. You can see the result in Picture 3-15.  

 

 
 

Picture 3-15 
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CREATING WORK STEP “3_FINISHING” 
In our third work step we will finish the cavity surface using our most efficient finishing 
technique “3D Equidistant”. This technique ensures an equal 3D distance between adja-
cent toolpath passes resulting in an even surface roughness all over the part eliminating 
the need for another finishing operation if the step over value is adequate. 
 
1. Select the “3D Machining Wizard” command in the “Machining” menu or click the 

corresponding button. 

3D Machining Wizard 
 
2. Input “3_FINISHING” as the new Work Step ID. Confirm with OK. 

 
 
3. Select “FINISHING” from the Method list box. 

 

 
 
 
4. Select “3D Equidistant” from the Toolpath Type list box. 

 
5. Select “outer-1” from the Path list box to define outermost machining boundary. 

 
6. Select “inner” from the 2nd Path list box to define the island region that should not 

be machined by the finishing operation. 
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7. On the “3D Machining Wizard” window, change the settings according to the table 
below and ensure that all parameters are set as shown in Picture 3-16. 

 

Dialog Field Value Comment 

Type Ball Ball type endmill 

Number 3 New tool number for finishing operation 

Diameter (Bot.) 0.375 Defines the full diameter of the tool  

Spindle RPM 1500 Sets spindle RPM to 1500 

Feed (X-Y) 30 Cutting feed rate in XY plane (inches/minute) 

Feed (Z) 5 Cutting feed rate for Z depth moves 

Step S-Link 

This parameter controls the step over moves 
between toolpath passes. S-Link eliminates 
any possible corner on the step over move 
eliminating knocking effect and ensuring 
smoother operation of the machine 

Fin Allow 0 
Finishing allowance value is set to 0 to reach 
the final surface after performing this operation 

Step Over 10% 

For 3D Equidistant type of toolpath Step Over 
is the 3D distance between the tool passes. 
The value is given as the percentage of the 
tool diameter. Since we want to leave minimal 
cusps on the surface “Step Over” distance is 
set as 10% of the tool diameter. However, low-
er values can be preferred to obtain smoother 
surface finish. 

Outside-In Mill-
ing 

ON 

Click this checkbox to generate the toolpath 
starting from the outermost loop and collapsing 
to the center. This ensures toolpath loops ar-
ranged from top to bottom 
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Picture 3-16 
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7. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-17. 

Verify 

 
 

Picture 3-17 
 
 
 

The Work Step #3 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP “4_RE-FINISHING” 
In our last machining work step we will remove the material left in the areas with smaller 
indentation and concavity than the Finishing tool could complete. We will select the last 
finishing operation as the Reference Work Step and pick a relatively smaller tool. Then 
the system will automatically detect the uncut boundaries and generate a 3D Equidistant 
finishing toolpath. 
 
1. Select the “3D Machining Wizard” command in the “Machining” menu or click the 

corresponding button. 

3D Machining Wizard 
 
2. Input “4_RE-FINISHING” as the new Work Step ID. Confirm with OK. 

 
 
3. Select “RE-FINISHING” from the Method list box. 

 

 
 
 
4. Select “3_FINISHING” from the Ref.Work Step list box. 
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5. On the “3D Machining Wizard” window, change the settings according to the Pic-
ture 3-18 below and ensure that all parameters are the same. 

 
 

 
 

Picture 3-18 
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6. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-19. 

Verify 

 
 

Picture 3-19 
 
 
 

The Work Step #4 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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3D SOLID MODEL PREVIEW 
One of the most powerful EZ-CAM features is the 3D solid preview function. This func-
tion shows an animated tool cutting a solid model of the programmed part. After pre-
viewing our program we are left with an accurate solid model representation, which al-
lows us to closely examine the surface finish and resulting part details. If no stock was 
defined prior to calling the “3D Preview” or “RapidCut” commands, the system automat-
ically calculates the stock size by adding a small margin to the sides and to the bottom of 
the visible solid model on the screen. 
 
1. Select the “Stock & Optimization Setup” command from the “Machining” menu and 

click “Auto Setup”, values should appear as shown in Picture 3-20. You may also 
enter your own values if the stock is different from the solid model boundaries. 
Clicking and activating “Clash Detection” makes the system detect and warn you 
about the collisions between the tool and the stock. Also click “Save Simulation” to 
enable browsing through simulation results of each work step (see Paragraph – 4). 
Close the dialog with OK. 

 

 
 

Picture 3-20 
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It is not necessary to open “Stock & Optimization Setup” window 
and run Auto Setup if you are executing the solid simulation for the 
“first time”, system calculates the stock boundaries automatically. 
But if somehow the stock size or position is improper at any time, 
you may need to run Auto Setup or input your own values that de-
scribe the real stock that will be mounted on the CNC machine. 
 
If you need information about using custom stock for the solid simu-
lation please refer to the Indexing section of the “EZ-MILL 4th Axis 
Tutorial”. 

 
 
2. Start the simulation using “3D Preview” command from the “Machining” menu or 

the corresponding button. The simulation speed can be controlled any time by press-
ing one of the numeric keyboard buttons (not the ones on the num-pad side), ranging 
from 1 (slowest) to 9 (fastest). Pressing 0 will activate Step Mode. If you need to see 
the simulation result immediately, you can use “RapidCut” command by executing it 
from the “Machining” menu or the corresponding button. The simulation result is 
shown in Picture 3-21. 

 
3D Preview Rapid Cut 

 

 
 

Picture 3-21 
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3. During 3D simulation you can change the on-screen view by using the dynamic view 
commands (Rotate, Pan, Zoom) with their corresponding buttons. Alternatively you 
can activate rotate by holding down right button and pan by holding down middle 
button of the mouse while dragging it on the screen. As usual mouse wheel executes 
zoom command during the simulation as well. 

 
Dynamic Rotate Dynamic Zoom Dynamic Pan

 
 

4. After completing the 3D simulation it is possible to browse through the simulation 
results of each work step. Simply click the desired works step from the list box at the 
right size of the screen and EZ-CAM instantly shows the situation at the end of the 
selected work step. Click “2_RE-ROUGHING” in the Work Step list box, you will 
see the simulation result at the end of second operation “re-roughing”. See Picture 3-
22. 

 
 

 
 

Picture 3-22 
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5. Click “3_FINISHING” in the Work Step list box, you will see the simulation result 
of the third operation “finishing”. See Picture 3-23. 

 
 

 
 

Picture 3-23 
 
 

   

Alternatively, after first clicking on one of the work steps in the list 

box you can use “up”  and “down”  arrow keys on the key-
board in order to browse through the simulation stages. 
 
If you have returned to the CAD view and now want to see the 
simulation model at a specific work step (or to start simulation from 
the corresponding stage), use Recall Part command from “Machin-
ing” menu to view the model at the end of the active work step (that 
is selected in the list box) and then start simulation. 

 
 
 

Congratulations! 
 

You've completed the EZ-MILL Pro 3D Machining Wizard Tutorial ! 
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OVERVIEW 
This tutorial is intended for users with little, or no experience in EZ-TURN operations. 
The step-by-step instructions describe the complete process of creating the NC program 
for the part shown in Picture 3-1, focusing on the machining process and also describing 
advanced techniques used for roughing and finishing. 
 
 

BASIC PROGRAMMING STEPS 
Before we continue with the tutorial let us explain the basic steps needed to create a part 
program with EZ-Turn. 
 
 
STEP 1.  Create Geometry 

Start by creating part geometry via commands under the Geometry 
Menu. 

 
STEP 2.  Create Work Steps and set Machining Parameters 

Define Work Steps for each machining operation and apply the pa-
rameters as required by type of operation and tool that is used. Create 
and assign a path curve to each Work Step. Visualize the computed tool 
path to assure correct tool operation and proper setting of machining 
parameters. 

 
STEP 3.  Post G-Code 

Select the “Postprocessor” related to the type of control and let the 
software create the G-Code file. 

 
 
 

   
The EZ-Turn Tutorial is set up in Inch with all Inputs and Dimen-

sions in Inch ! 
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Blueprint of EZ-Turn Tutorial 
 

Picture 4-1 
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 DEFINING ORIGIN, WINDOW SIZE AND LOCATION 
The window size is the distance from the edge of the window to the center of the win-
dow. The window location is the signed, absolute position of the window center from the 
part’s origin. The viewing parameters that are found in the Setup dialog box specify the 
size and location of the window. Note that you would not normally perform this step in 
programming a part, but it is necessary here to insure clarity in following the tutorial. 
Normally, you would just use the Zoom/Fade commands to set the window size as need-
ed. 
 
When selecting the origin for the part, choose a location that is referenced by the part’s 
dimensions. The origin should be selected before defining the window location (see next 
topic for setting up the workspace), because the window center is referenced from the 
part's origin. The graphic in Picture 4-2 below shows the location of the part origin for 
this exercise (X = -1.5 , Y = 1.5). 
 
 
 

Window Size ( 2.0 )

Window Center

Part Origin

X Center ( -1.5 )

Y Center ( 1.5 )

 

 
 

Picture 4-2 
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SETTING PREFERENCES 
Before continuing with the construction of the sample part, several parameters should be 
set so that the system is compatible with the instructions in this tutorial. Also the size of 
the workspace should be set. The sample part is about 3-inch in the Z-axis and 6-inch in 
the X-axis. Because of the size of the part, it is not convenient to work in the default win-
dow; therefore, the window and some default settings have to be changed. 
 
1. Select ”New” command from the “File” menu to restart EZ-CAM and the clear the 

memory before continuing with the tutorial. Make sure that the “TURN” button is 
activated before pressing OK to start over. 

 

 
 
 

  
 

The “New” dialog is also used to switch between the EZ-Mill and 
EZ-Turn module. Before the dialog opens, the system checks the 
software protection key for activated modules. Modules or levels 
that are not activated will be marked by appended “DEMO” text. 
When working in “Demo” (evaluation) mode, it is not possible to 
print or save data. The corresponding “Save”,  “Save as” and 
“Print” commands are disabled. 
 
When closing the EZCAM application, the system automatically 
stores the last used level as default for the next session. 

 
 
2. Select ”Setup” command from the “View” menu 

 

3. Type “1.5” for “X Center”, “-1.5” for “Y Center” and “2” for “Size”. This sets the 
window size from the edge of the window to the center of the window, allowing 
enough room to see all of the part as it is created. See Picture 4-2. 
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4. Select “Inch” option button as the parts input dimension system. 

 

5. Click the “Background” list box and select “Black”. 

 

6. Select “Diameter Input” option button as the parts X-axis input system. 

 

7. Disable “Enable Y coordinate entry” option. 

 

8. Enable “Blank Verify”, “Show curve direction” and “Save as default” options. Then 
close the dialog with OK button. 

 
 

 
 

Picture 4-3 
 
 
The initial setup for the TURN tutorial is now complete. Continue with the next section 
to create the geometry necessary for this part. 
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THE PART GEOMETRY 
Now that the workspace has been adjusted to accommodate the part, the creation of the 
part can begin. This involves creating geometry that is used to define the path curves for 
machining the part. The geometry is created first, so that the process of creating the 
curves is greatly simplified. 
 
First, we will define the basic geometry that defines the outside contour of the sample 
part. Then we continue with inserting the various fillets. At any time you may use the 
Undo/Redo buttons in the upper left corner to correct any mistakes you make. 
 
 
1. Select the “Connected Lines” command from the “Geometry” menu or click the cor-

responding button on the toolbar. 

Connected 
Lines 

 

2. EZ-TURN prompts you to pick the first point. Type “-3” in the “Z” field of the Val-
ue Entry Box. Then press Tab to move the focus to the “X” input field. Type “1.375” 
for the X location and press the ENTER button to confirm the first point. 

 
 Z X 

P1 -3.0 1.375 

 
3. Continue entering the Z and X values for points  #2  to  #17  as listed in the table 

below. Press ENTER for each point to confirm the Z and X input. When finished the 
part geometry should appear as in Picture 4-4. 

 

 Z X 

P2 -1.6 1.375 

P3 -1.6 2.3 

P4 -1.15 2.3 

P5 -1.15 3.02 

P6 -1.025 3.02 

P7 -1.025 2.73 
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 Z X 

P8 -0.15 2.73 

P9   0 3.03 

P10   0 3.6 

P11 -0.2 4.0 

P12 -0.5 4.0 

P13 -0.5 4.3 

P14 -1.0 4.3 

P15 -1.0 4.6 

P16 -1.875 4.6 

P17 -1.875 6.0 

P18 -3.0 6.0 

 
 
 
 

 
X

ZY

 

 
Picture 4-4 
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CREATING FILLETS 
Follow the instructions below to create corner fillets for the sample part. 
 
1. Select the “Corner Fillet” command from the “Geometry” menu or click the corre-

sponding button on the toolbar. 

Corner Fillet 
 

2. Type “1/32” or “0. 03125” in the “R” field of the Value Entry Box. This sets the ra-
dius for the corner fillet at 1/32". Place and click the cursor at each position shown in 
Picture 4-5. 

 
 
 

 
X

ZY

Cursor Positions to insert
       the R1/32 fillets

 

 
 

Picture 4-5 
 
 
 
4. Type “0.25” for the ¼-inch fillet in the “R” field of the Value Entry Box and click 

the cursor at the position shown on Picture 4-6. 
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5. Type “0.125” for the 1/8-inch fillet in the “R” field of the Value Entry Box and click 
the cursor at the position shown on Picture 4-6. 

 
 
 

 
X

ZY

Cursor Position to insert
the 1/8 inch fillet

Cursor Position to insert
the 1/4 inch fillet

 

 
 

Picture 4-6 
 
 
 

   
If you want to save the newly created geometry before continuing, 
jump to the “Saving the Part” section at the end of the EZ-TURN 
tutorial. 
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CREATING THE PART PROGRAM 
Now as the geometry for the Turn tutorial is completed we continue with creation of the 
Work Steps necessary to machine the part. Select the desired cycle (Profile, Turn, Bore, 
etc.), specify associated tool settings and machining parameters and define the path repre-
senting the profile to be machined. Finally verifying the calculated tool path assures cor-
rect tool operation. When all necessary Work Steps have been defined, the complete part 
program can again be verified for visual checks. If everything is ok continue to the next 
step and create the CNC-Code. 
 
 

   
During Work Step creation you will see dialogs that display many 
parameters and settings. As it is simply not possible to give de-
tailed information on every parameter within this tutorial you may 
use the integrated context sensitive “What’s This?” help function 
to get a brief description on any desired dialog item. 
 

 
 
Simply select the “?” button in the upper right of the dialog and 
click on any parameter label or dialog section. The information 
will be displayed in a separate window as shown below. 
 

 
 

 



EZ-TURN TUTORIAL 

EZ-CAM 4-11 

 
The part program of the tutorial will consist of these 8 Work Steps: 
 
 
1. Face the front surface. 

2. Turn the exterior surfaces and allow stock for the finishing operation. 

3. Profile the exterior to a finished surface. 

4. Drill the center of the part. 

5. Bore the inner surface to two different diameters, allowing stock for the finishing 
operation. 

6. Profile the interior drilled and bored surfaces to the finish ID’s. 

7. Create a Groove to allow for thread tool retraction. 

8. Thread the ID at 4 TPI (threads per inch). 

 
 
 

   
Execution of the Work Steps will be in the same order they have 
been created. You can use the integrated spreadsheet to perform 
operations such as moving, reordering or deleting existing Work 
Steps. 
 
See the “Spreadsheet” book in the online help for more detailed 
information. 
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CREATING WORK STEP #1  (FACE MACHINING) 
Now we create the first Work Step selecting a facing cycle that will take a small amount 
of material off the stock to make it an even surface.  
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
 
2. Press the “New” button and input “1-Face” as the new Work Step ID and confirm 

with OK (1 identifies the Work Step number, and FACE is simply a description of 
the purpose of the Work Step). 

 

 
 
3. Select “Face” from the cycle list. 

 
 
4. Now we select a tool. For this click the “Select Tool” button from the “Tool Info” 

tab to open the “Select Tool” dialog box. If there are no tools available select the 
“Change” button to load the “INCHTOOL.TLS” database from the “EZCAMW \ 
EZCAM..” directory. “EZCAM..” stands for the directory of the currently installed 
software release (EZCAM12, EZCAM13, etc.). This tool library has all tools needed 
for the tutorial. 
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 Once the database is loaded highlight the tool ID “301” (80 degree diamond insert, 

tip radius 0.03125) and click the “Select” button as shown in Picture 4-7. 

 

 
 

Picture 4-7 
 
 
5. As we are already on the “Tool Info” tab, change the dialog settings as shown in the 

table below. See Picture 4-8 for the full dialog. 

 

Dialog Field Value Comment 

  Number 1 
This number represents the tool position on 
the tool turret / magazine. 

  Offset # 1 
Specifies the register number on the control 
were the current tool’s offset compensation 
values are stored. 

  Z Index 5 Tool change position for Z axis 

  X Index 10 Tool change position for X-axis 

  Coolant FLOOD  
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Picture 4-8 
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6. Now select the “Cycle Data” tab and change settings according to the table below. 

Close the dialog using the “Close” button. See Picture 4-9. 

 

Dialog Field Value Comment 

Z Fin Allow 0 
Finish allowance for the X / Z-axes. 

X Fin Allow 0 

Clear 0.05 
Clearance distance between material bounda-
ry and tool tip at the start of the cycle. 

Withdraw Angle 45 
Angle applied to retract move at the end of 
each roughing pass. 

Withdraw Length 0.05 Length of retract move at the end of each 
roughing pass. 

Depth   0.1 Incremental depth increment for each pass. 

CSS Status ON 
When constant surface speed is set to ON, the 
machine tool automatically adjusts the RPM to 
maintain the specified CSS value. 

CSS Value 400 Sets constant surface speed (feed / minute). 

Max RPM 2500 Sets maximum spindle RPM if CSS ON. 

Feed Units UPR Sets Feed Rate type to Units Per Round. 

Feed Rate 0.025 Feedrate rough passes 

Engage Feed 0.05 Feedrate depth moves 

Withdraw Feed 0.05 Feedrate retract moves 

Stock Curve Manual 
Stock curve defined manual. Roughing bound-
aries specified by the Inner/Outer-Diameter 
and Left/Right-Boundary as listed below.  

Inner Dia 0 Inside stock diameter 

Outer Dia 6.0 Outside stock diameter 

Left Bound 0 Absolute Z position for left stock boundary 

Right Bound 0.3 Absolute Z position for right stock boundary 
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Picture 4-9 
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CREATING TOOL PATH FOR WORK STEP #1 
Now that all of the machining parameters have been defined, a path curve must be creat-
ed. EZ-Turn uses the curve entity to define a cutter path for each machining Work Step. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv1-Face” as the new ID and confirm with OK 
(Crv1 is the systems default ID and FACE is simply a description of the purpose of 
the curve). 

 
New 

 
2. Select the “Linear” command from the “Curves” menu or click  

Linear 
 
3.  The curve for this Work Step will consist of only one single linear move. To define 

the first point type “0” in the “Z” field of the Value Entry Box. Press Tab to move 
the focus to the “X” input field. Type “6” for the X location and press the ENTER 
button to confirm the first point. A small triangle is displayed on the screen. 

 
4.  For the second point type “0” for the X location (“Z” is already “0”) and press the 

ENTER button to confirm the second point. A blue line representing the new curve is 
now visible on the screen 

 
5. Now we assign the new curve to the previously created Work Step. If you look at the 

Path Status button at the bottom of the screen, you’ll see that there is no curve ID 
displayed indicating that no tool path has been assigned to the current Work Step. 

 
Click the “Path” status button and select the Curve ID “Crv1-Face” from the Selec-
tion List Box. The status button will now show the ID of the selected curve. 
 

 
 

 

Path Status Button Selection List Box Path Status Button displaying 
curve selected for the current 

Work Step 
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6. Click the “Verify” button to calculate and display the tool path on the screen as 
shown in Picture 4-10. 

Verify 
 
 

 
 

Picture 4-10 
 
 
 

The Work Step #1 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #2  (TURNING CYCLE) 
The next step in creating the part program is to set up the turning cycle that turns down 
the exterior surfaces. 
 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog and select the 

“Tool Info” tab. 

 

 
 
2. Press the “New” button and input “2-Turn” as the new Work Step ID and confirm 

with OK. 

 
 
3. Select “Turn” from the cycle list. Don’t worry about the currently selected path 

curve. This will be changed later. 

 

 
 
 
4. Ensure that all parameters on the “Cycle Data” tab are set as listed in the table be-

low. Other settings (also on “Tool Info” tab) are identical to the previous Work Step. 
Close the dialog using the “Close” button. 

 

Dialog Field Value Comment 

Z Fin Allow 0.005 The “Fin Allow” settings specify separate finish 
allowance values for the X and Z axes 

X Fin Allow 0.01 
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Clear 0.1 
Clearance distance between the material 
boundary and the tool tip at the start of the cy-
cle. 

Withdraw Angle 45 Angle applied to retract move at the end of 
each roughing pass. 

Withdraw Length 0.025 
Length of move when retracting at the end of 
each roughing pass. 

Depth   0.075 
Depth increment for each pass of roughing 
routine. 

Inner Dia 0 Inside stock diameter 

Outer Dia 6.0 Outside stock diameter 

Left Bound -3.0 Absolute Z position for left stock boundary 

Right Bound 0 Absolute Z position for right stock boundary 

 
 
 

CREATING TOOL PATH FOR WORK STEP #2 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv2-Turn” as the new ID and confirm with OK. 

 
New 

 
 
2. Select the “Chain” command from the “Curves” menu or click the corresponding 

button. 

Chain 
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3. The prompt “Pick first line, arc, circle, or point figure” is displayed at the bottom 

edge of the window. Move the cursor to the position shown in Picture 4-11 and dou-
ble-click the mouse to select the line as the first element in the curve chain. The 
software automatically completes the curve by following the connected geometry el-
ements from the first point to the last. A small arrow referred to as the “direction in-
dicator” visualizes the curve direction. 

 
 

Double-Click here to "Chain"
the Curve for Work Step #2

 

 

X

ZY  
 

Picture 4-11 
 
 

 

In case path chaining failed for some reason (selected wrong ele-
ment or position), simply delete any already existing path ele-
ments by using the “Delete All Links” command from “Curves" 
menu.  Then select “Chain” command and try again. 

 
 
4. To assign the new curve to the previously created Work Step press the “Path” status 

button and select the Curve ID “Crv2-Turn” from the Selection List Box. The status 
button will now show the ID of the selected curve. 
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5. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-12. 

Verify 
 
 

 
 

Picture 4-12 
 
 
 

The Work Step #2 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #3  (PROFILING CYCLE) 
The profiling cycle is a finishing operation to reduce the roughening caused by the turn-
ing path. We select a new tool and assign specific finishing parameters. The same path 
curve as in the previous Work Step will be used. 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog and select 

the “Tool Info” tab. 

 
 
2. Press the “New” button and input “3-Profile” as the new Work Step ID and confirm 

with OK. 

 
 
3. Select “Profile” from the cycle list. As the previous Work Step curve is automatical-

ly copied when a new Work Step is created the “Path ID” field should already show 
“Crv2-Turn”. 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. Highlight the tool ID “304” (60 degree diamond insert, tip radius 0.016) 
from the list and click the “Select” button to load the tool.  

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 2 Tool number on the tool turret / magazine. 

Offset # 2 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 

Close the dialog using the “Close” button. 

 

Dialog Field Value Comment 

Offset Dir RIGHT 

This setting controls how the tool is placed in 
relation to the path. The direction is always de-
termined by looking in the cutting direction 
(path direction) from behind the tool. 

Z Fin Allow 0 Finish allowance for the X and Z-axes. 

X Fin Allow 0  

Feed Rate 0.005 Feedrate finish pass. 

 
7. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-13. 

Verify 
 

 
Picture 4-13 

 

The Work Step #3 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #4  (DRILLING CYCLE) 
The purpose of this cycle is to drill through the center of the part, to allow for the thread 
and groove creation later in the part program. 
 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog and select the 

“Tool Info” tab. 

 
 
2. Press the “New” button and input “4-Drill” as the new Work Step ID and confirm 

with OK. 

 
 
3. Select “Drill” from the cycle list. Don’t worry about the “Path ID” field still showing 

“Crv2-Turn”. We will create and assign a new path curve later. 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. Select “Drill” from the “Type” list box to list drill tools only. Click the 
tool ID “Drill1375”(1.375 diameter, 120 degree included tip angle) from the list and 
pick the “Select” button to load the tool. 

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 3 Tool number on the tool turret / magazine. 

Offset # 3 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 
Close the dialog using the “Close” button. 

 

Dialog Field Value Comment 

Operations Drill Standard drilling operation 

Clear 0.05 
Clearance distance between the material 
boundary and the tool tip at the start of the drill 
cycle. 

Depth 3.4 
Total depth increment for the DRILL cycle (3.0 
+ tooltip length). 

Step 1 0.5 First peck increment. 

Step 2 0.25 
Second and subsequent peck increments, step 
2-n. 

Spindle RPM 800 Sets constant speed to 800 rpm/ minute. 

CSS Status OFF 
Set constant surface speed to OFF for switch-
ing to constant spindle RPM. 

Feed rate 0.005 Feed rate for drilling moves 

 
 

CREATING TOOL PATH FOR WORK STEP #4 
The drill cycle curve requires only one point for its path definition. The “Depth” parame-
ter from the “Cycle Data” tab will be referenced from this point. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv4-Drill” as the new ID and confirm with OK. 

 
New 

 
2. To create the path click the “Linear” button or select the command in the “Curve” 

menu.  

Linear 
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3.  The curve for this Work Step will consist of only one single point that reflects the 

starting point of the drilled hole. Type “0” in the “Z” and “X” fields of the Value En-
try Box to specify the center location. Press ENTER to confirm the point. A small 
triangle is displayed on the screen. 

 
4. Now we have to assign the new curve to the previously created Work Step. Click the 

“Path” status button and select the Curve ID “Crv4-Drill” from the Selection List 
Box. The status button will now show the ID of the selected curve. 

 

 
 
5. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-14. 

Verify 
 
 

 
 

Picture 4-14 
 
 

The Work Step #4 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #5  (BORING CYCLE) 
Now that the drilling cycle has been verified, the boring cycle must be created to bore the 
three different inside dimensions. 
 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog and select the 

“Tool Info” tab. 

 
 
2. Press the “New” button and input “5-Bore” as the new Work Step ID and confirm 

with OK. 

 
 
3. Select “Bore” from the cycle list. Don’t worry about the “Path ID” field still showing 

“Crv4-Drill”. We will create and assign a new curve later. 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. Select “Bore” from the “Type” list box to list bore tools only. Highlight 
the tool ID “403” (60 degree diamond insert, tip radius 0.032) from the list and click 
the “Select” button to load the tool. 

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 4 Tool number on the tool turret / magazine. 

Offset # 4 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 

Close the dialog using the “Close” button. 
 

Dialog Field Value Comment 

Z Fin Allow 0.005 
Finish allowance for the X and Z axes 

X Fin Allow 0.01 

Clear 0.1 Clearance between boundary and tool tip. 

Withdraw Length 0.025 Length of retract move. 

Depth   0.1 Depth increment for each roughing pass. 

CSS Status ON Activate Constant surface Speed (feed/min). 

CSS Value 400 Constant surface speed (feed / minute). 

Max RPM 2500 Sets maximum spindle RPM if CSS ON. 

Feed Units UPR Sets Feed Rate type to Units Per Round. 

Feed Rate 0.025 Feedrate rough passes 

Engage Feed 0.05 Feedrate depth moves 

Withdraw Feed 0.05 Feedrate retract moves 

Stock Curve NONE 

NONE=No stock curve defined. Roughing 
boundaries specified by the Inner/Outer-
Diameter and Left/Right-Boundary as listed be-
low.  

Inner Dia 1.375 Inside stock diameter 

Outer Dia 2.0 Outside stock diameter 

Left Bound -1.6 Absolute Z position for left stock boundary 

Right Bound 0 Absolute Z position for right stock boundary 
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CREATING TOOL PATH FOR WORK STEP #5 
The tool path creation for the boring cycle is going to make use of the Pick “Intersection 
of Two” button. This will allow for the bore to be completed while ignoring the groove 
previously established in the geometry. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv5-Bore” as the new ID and confirm with OK. 

 
New 

 
2. Select “Linear” from the “Curve” menu, then switch to the “Endpoint” pick mode 

from the “Edit/Point Picking” menu. You may also use the corresponding toolbar 
buttons. 

Linear Pick Endpoint 
 

Click the cursor on position #1 and #2 as shown in Picture 4-15 to create the first 
linear move of the new curve. 

 
3. Switch to the “Intersection of Two” pick mode from the “Edit/Point Picking” menu 

or use the corresponding button. The “Linear” curve command is still activated. 

Intersection 
of Two 

 
Click the cursor on positions #3 and  #4 as shown in Picture 4-15 to select the two 
lines from the geometry. The system automatically snaps to the intersection of both 
elements and creates the third point of the curve. 

 
4. Switch back to “Endpoint” pick mode and click the cursor on positions #5, #6 and #7 

as shown in Picture 4-15 to finish the curve creation. 

Pick Endpoint 
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Positions  #1 ,  #2 , #5 , #6 ,  #7

Positions  #3 ,  #4

#1

#2#4

 #5#6

#7

#3

 
 

Picture 4-15 
 
 
5.  As the last element of this curve we will append a rapid move to cause the tool to 

retract to a safe position before moving to the tool change location. Select the “Rap-
id” command from the “Curves” menu. Type “0.25” in the “Z” field and “1.2” to the 
“X” field of the Value Entry Box. Press ENTER to confirm the input. The rapid 
move is displayed as a dotted line. 

Rapid 
 
6. To assign the new curve to the previously created Work Step click the “Path” status 

button and select the Curve ID “Crv5-Bore” from the Selection List Box. 

 

 
 
7. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-16. 

Verify 
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Picture 4-16 
 
 
 

The Work Step #5 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #6  (PROFILING CYCLE) 
The next machining cycle is a profiling cycle of the previously bored surfaces. 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog. Once it is 

open switch to the “Tool Info” tab. 

 
 
2. Press the “New” button and input “6-Profile” as the new Work Step ID and confirm 

with OK.  

 
 
3. Select “Profile” from the cycle list. As the previous Work Step curve is automatically 

copied when a new Work Step is created the “Path ID” field should already show 
“Crv5-Bore”. 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. “Bore” tool type should still be active. Highlight the tool ID “407” (55 
degree diamond insert, tip radius 0.016) from the list and click the “Select” button to 
load the tool.  

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 5 Tool number on the tool turret / magazine. 

Offset # 5 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 
Close the dialog using the “Close” button. 

 

Dialog Field Value Comment 

Offset Dir LEFT 

This setting controls how the tool is placed in 
relation to the path. The direction is always de-
termined by looking in the cutting direction (path 
direction) from behind the tool. 

Z Fin Allow 0 
Finish allowance for the X and Z-axes. 

X Fin Allow 0 

Clear 0.05 Clearance between boundary and tool tip. 

Engage Angle 0 Angle applied to engage move 

Withdraw Angle 180 Angle applied to retract move 

Feed Rate 0.005 Feedrate finish pass. 
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7. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-17. 

Verify 
 

 
 

Picture 4-17 
 
 
 

The Work Step #6 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #7  (GROOVING CYCLE) 
The purpose of this cycle is to create a groove so that the tool can be retracted after the 
threads are created. It produces a rough finish that does not need to be profiled. 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog. Once it is 

open switch to the “Tool Info” tab. 

 
 
2. Press the “New” button and input “7-Groove” as the new Work Step ID and confirm 

with OK.  

 
 
3. Select “Groove” from the cycle list. The path curve will be assigned later. 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. Select “Groove” from the “Type” list box. Click the tool ID “551” (0.125 
width, tip radius 0.005, max. depth 0.25) from the list and press the “Select” button 
to load the tool.  

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 6 Tool number on the tool turret / magazine. 

Offset # 6 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 

Close the dialog using the “Close” button. 

 

Dialog Field Value Comment 

Operations ROUGH+FIN 

When using “Rough + Fin” option, the 
groove is rough machined first and final-
ly cleaned up with a finishing pass in-
cluding the bottom of the groove. 

Offset Dir. LEFT 

This setting controls how the tool is 
placed in relation to the machined path. 
The direction is always determined by 
looking in the cutting direction (path di-
rection) from behind the tool. 

Z Fin Allow 0 Additional finish allowance for the X and 
Z-axes. X Fin Allow 0 

Clear 0.05 
Clearance between start of groove pro-
file and tool tip. 

Lift Off 0.0025 Retract amount after each depth move. 

Depth 0.1 Depth for incremental depth moves. 

Stepover % 80 
% of tool width to define distance of 
plunge steps. 

Dwell 0.5 Dwell time at bottom of groove. 

CSS Value 250 Constant surface speed (feed / minute). 

Plunge Feed 0.0025 Plunge feed rate 

 
 
 

 

If you apply any combination of  “Z Fin/X Fin Allowance” to a 
groove cycle you have to create an additional Work Step to clean 
up the groove. 
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CREATING TOOL PATH FOR WORK STEP #7 
Before we continue there is one important thing to mention. Always specify a rapid move 
at begin and end of a curve if inside areas are machined. This causes the tool to start and 
retract from/to a safe position at begin and end of the machining operation. These moves 
will avoid crashes between tool and work piece. As the path for the tutorials groove cycle 
is located completely inside the part you will see rapid moves as the first and last curve 
element. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv7-Groove” as the new ID and confirm with 
OK. 

 
New 

 
2.  Select the “Rapid” command from the “Curves” menu to specify a rapid move as the 

first element of the new curve. Type “0.25” in the “Z” field and “2.0” in the “X” 
field of the Value Entry Box. Press ENTER to confirm the input of the first point. A 
small triangle is displayed on the screen. 

Rapid 
 

Then switch to the “Endpoint” pick mode from the “Edit/Point Picking” menu. Click 
the cursor on position #1 as shown in Picture 4-18. A dotted line representing the 
rapid curve move will be drawn on the screen. 

Pick Endpoint 
 
3. To continue with the groove profile select “Linear” from the “Curves” menu. The 

“Endpoint” pick mode is still activated. Click the cursor on positions #2 and #3 as 
shown in Picture 4-18. 

Linear Pick Endpoint 
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Positions  #1 ,  #2 , #3

#1

#2#3

Rapid Move

 

 
Picture 4-18 

 
 
4. Switch to the “Intersection of Two” pick mode from the “Edit/Point Picking” menu 

or use the corresponding button. The “Linear” curve command is still active. 

Intersection 
of Two 

 
Click the cursor on positions #4 and  #5 as shown in Picture 4-19 to select the two 
linear geometry elements. The system automatically snaps to the intersection of both 
elements and creates the last groove position. 

 

 

Position  #6

Positions  #4 ,  #5

 #4

#5

Rapid Move as the last
      Curve Element

 

#6

 
Picture 4-19 
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5.  For the last curve element select the “Rapid” command again. This move will specify 

the tool’s “retract” position at the end of the machining sequence. Switch to the 
“Snap All’ pick mode and click at the position #6 as shown in Picture 4-19. 

Rapid Snap All 
 

6. To assign the new curve to the previously created Work Step click the “Path” status 
button and select the Curve ID “Crv7-Groove” from the Selection List Box. 

 

 
 
7. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-20. 

Verify 
 

i  
 

Picture 4-20 
 

The Work Step #7 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #8  (THREADING CYCLE) 
The threading cycle is the last machining cycle for the sample part. This cycle creates a 
standard UNC thread in the larger of the two bore diameters created earlier. 
 
 
1. Click the Work Step Data button to open the “Work Step Data” dialog. Once it is 

open switch to the “Tool Info” tab. 

 
 
2. Press the “New” button and input “8-Thread” as the new Work Step ID and confirm 

with OK.  

 
 
3. Select “Thread” from the cycle list. The path curve will be assigned later. 

 

 
 
4. Click the “Select Tool” button from the “Tool Info” tab to open the “Select Tool” 

dialog box. Select “Thread” from the “Type” list box. Highlight the tool ID “651” 
(60 degree angle) from the list and click the “Select” button to load the tool.  

 
5. On the “Tool Info” tab, change the settings as shown in the table below. 

 

Dialog Field Value Comment 

Number 7 Tool number on the tool turret / magazine. 

Offset # 7 Tool’s offset register number.  
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6. On the “Cycle Data” tab ensure that the parameters listed below are set correctly. 

Close the dialog using the “Close” button. See Picture 4-21 

 

Dialog Field Value Comment 

Steps FIXED 

Controls how thread passes/depth are de-
fined. For ‘Fixed’ type, enter the “Total 
Steps” and “Depth” required for the thread-
ing operation. The decreasing depth in-
crement for each pass is then calculated 
by the system in order keep a constant 
volume of removal. 

Start Clear 0.25 Lead-In distance for thread passes. 

End Clear 0.05 
Specifies distance the tool feeds past the 
end of the thread before retracting (refers 
to the end point of the “Thread” path). 

Withdraw Clear 0.05 Retract amount after each threading pass. 

Engage Angle -60 

Specifies the engage angle of each pass. 
The value “-60” degree specified here will 
cause the tool to cut only on one side of 
the tool tip because the Z-axis start posi-
tion of each pass is slightly shifted towards 
the work piece based on current depth in-
crement and engage angle. 

Withdraw Angle 90 Retract angle at end of threading passes 

Z Lead 0.25 
Sets the "tip to tip" lead along the Z-axis 
(lead from thread tip to thread tip, or 
"pitch"). 

Depth 0.1325 Total depth of the thread 

Total Steps 6 

Sets the total number of steps required for 
the threading operation. This parameter is 
only applicable when "Fixed" has been se-
lected in the “Steps” List Box. 

Spring Passes 1 
Number of spring passes at thread com-
pletion 

Spindle RPM 700 Sets constant spindle RPM to 800 / minute 

CSS Status OFF Set constant spindle RPM for threading. 
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Picture 4-21 
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CREATING TOOL PATH FOR WORK STEP #8 
The threading path curve only requires a single linear move. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv8-Thread” as the new ID and confirm with 
OK. 

 
New 

 
2. To create the path select “Linear” from the “Curve” menu, then switch to the “End-

point” pick mode from the “Edit/Point Picking” menu. You may also use the corre-
sponding toolbar buttons. Click the cursor on positions #1 and  #2 as shown in Pic-
ture 4-22. 

Linear Pick Endpoint 
 
 
 

X

ZY

#1#2

 

 
 

Picture 4-22 
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3.  Finally select the “Rapid” command from the “Curves” menu. Type “0.25” in the 

“Z” field and “2” in the “X” field of the Value Entry Box. Press ENTER to confirm 
your input and the rapid element is appended to the curve. 

Rapid 
 
4. To assign the new curve to the previously created Work Step click the “Path” status 

button and select the Curve ID “Crv8-Thread” from the Selection List Box. 

 

 
 
5. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 4-23. 

Verify 
 

 
 

Picture 4-23 
 
 

The Work Step #8 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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VERIFYING ALL TOOL PATHS 
In this tutorial, you have verified the tool path of each Work Step individually. The “Ver-
ify All” command in the “Post” menu is used to estimate the total time it will take to ma-
chine the part. It automatically performs an on-screen verification of all of the part pro-
gram Work Steps in memory, in the machining order. The total machining time (exclud-
ing rapid traverse or tool change time) is displayed in a dialog box at the end of the veri-
fication process. 

 
Verify All 
 
 
 

 
 
 

Picture 4-24 
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3D SOLID PREVIEW 
One of the most powerful EZ-CAM features is the 3D solid preview function. This func-
tion shows an animated tool cutting a solid model of the programmed part. The stock size 
is automatically calculated according to the calculated tool movements. Once the simula-
tion is finished or interrupted by the user pressing “Esc” key, all dynamic view com-
mands to rotate, zoom or move the simulated model on the screen are available. 
 
 
1. Select the “Preview 3D” command from the “Machining” menu or the corresponding 

button. See Picture 4-25.  

Preview 3D 
 

 
 

Picture 4-25 
 
 
2. Once the simulation stopped you can change the on-screen view by using the dynam-

ic view commands (Rotate, Pan, Zoom) under the “View / Dynamic Viewing” menu. 

Dynamic Rotate Dynamic Zoom Dynamic Pan
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SAVING THE PART 
It is very important to save the newly created or edited part from memory to disk periodi-
cally during a session as well as at the end to ensure that no information is lost. The EZ-
CAM “Save” and “Save as” commands under the File menu transfer files from system 
memory to a hard disk or other media. In EZ-TURN, the part information is stored in two 
different types of files, the “Part” file using the extension "TRN" and the associated “Ge-
ometry” file with extension "GEO". This flexibility allows the user to load an existing 
part file to be used with newly created geometry and path curves. 
 
File Type  : GEOMETRY 
Extension : GEO 
Data  : Geometry Elements (lines, arcs, etc.), Curves, 

  User-Coordinate Systems (UCS) 
 
File Type  : PART Files 
Extension : TRN 
Data     : Work Step Data (Technology & Machining Information) 
 
There is no specific rule what should be saved first. Of course, if there is only one kind of 
data in memory (Work Steps or Geometry) the “Save as” dialog will automatically open 
with the correct file type. 
 
 

 
 

Picture 4-26 
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1. Select “Save as” command from the “File” menu. 

 

2. Select the appropriate drive and folder where the geometry and part files should be 
stored. You can use the “EZCAMW \ TURNPARTS” folder that was automatically 
created by the setup routine. 

 

3. Select “Geometry (*.GEO)” from the “Save as type” list box to store the geometry 
data. 

 

4. Type the new filename “Turn-Tutorial” in the File Name box and click the “Save” 
button. The file extension is added automatically.  

 

5. To store the machining information (Work Step Data) select “Part Files (*.TRN)” 
from the “Save as type” list box and click “Save” again. 

 
 

   
If you have already saved the geometry, the software automatical-
ly inserts a part file with the same name but different extension 
(*.3DP) in the “Save” menu when the first Work Step is created. 
All you have to do is to select “Save All” option from the “File” 
menu or the corresponding toolbar button. 
 

 
 
Save 
All 

 

 
 
 
 

 

The software will save and overwrite the existing files without 
any screen prompt. You can use this command anytime for fast 
saving of your work. 
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It is not possible to save data when the software is running in 
evaluation mode. The “Save”, “Save as” and “Print” commands 
are disabled. 

 
 

CREATING CNC CODE 
Now that the part program has been created, it must be converted to run on a NC control 
by running the “Post” command with the appropriate “Post-Processor” for your machine. 
 

   
 

The CNC data file or “Post-Processor” is used as a "template" to 
format the part program data file that was created in EZ-Turn. 
This template consists of program formats (e.g., TOOL 
CHANGE, LINEAR MOVE, etc.) that determine the structure of 
a part program for a specific CNC. To create or edit a “Post-
Processor” a special editor called “TBuild” is required. 

 
1. Select “Post” command in the “Machining” menu to open the “Post Process” dialog. 

 

 
 

Picture 4-27 
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2. First you need to select the postprocessor. If the one desired is already loaded and 

displayed in the section “CNC-File”, continue to the next step. Otherwise use the 
“Change” button to browse your system for a different one. For this tutorial you may 
use the “FAN-18TI.CNC” post (standard inch post that creates Fanuc style code). 

 

   
 

Standard postprocessor folders created by the EZ-CAM v15 setup: 
 
INCH 
<DRIVE>: \ EZCAMW \ EZCAM15 \TURNINCHPOST 
 
METRIC 
<DRIVE>: \ EZCAMW \ EZCAM15 \TURNMETRICPOST 

 
3. Select the “G-Code” option from the “Listings” list box. The computed program text 

will be displayed on the screen. 

 

4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” 
application when posting of the part file is finished and load the newly created file 
for sending it top the machine using the serial port. See Chapter 6 “Communication 
with the Control” for more information about EZ-DNC. 

 

5. Next is the “G-Code File” section. Here the default name and directory for the com-
puted program file is displayed. The name is taken from the part file that was saved 
before. The default directory is “EZCAMW\TURNGCODE”. 

 

   
 

Ensure that part file and postprocessor share the same dimension 
unit (“Inch” for this tutorial). The system will generate a “Dimen-
sion Unit Conflict” message, but then automatically scale the NC-
Code according to the dimension specified in the postprocessor.  
  
See online help for more information about the “Setup” dialog lo-
cated in the “View” menu. 

 

6. Click the “Post” to start posting. The Processing window will be displayed showing 
messages followed by listings of ASCII code created. When all Work Steps have 
been processed, a final message box is shown. See Picture 4-28. 
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Picture 4-28 
 
 
7. Click OK to close the message dialog box. To close the Processing window 

click  at the top right-hand corner of the window. 

 
 
 

Congratulations! 
 

 You've completed the EZ-TURN Tutorial !
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OVERVIEW 
This tutorial is intended for users with little, or no experience in EZ-TURN “Milling Op-
erations”. The step-by-step instructions describe the complete process of creating the NC 
program for the part shown in Picture 5-1 and Picture 5-2, focusing on the machining 
processes including C and Y-axis rotary tool operations (milling, drilling). 
  
We will begin with regular turning operations to create the basic shape of the part.  Then 
holes, slots and pockets on face and side of the part will be added by using the feature 
like turn-mill machining cycles of EZ-TURN. 
 
 
 
 

 
Picture 5-1 
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BASIC PROGRAMMING STEPS 
Before we continue with the tutorial let us explain the basic steps needed to create a part 
program with EZ-Turn. 
 
 
STEP 1.  Create Geometry 

Start by creating part geometry via commands under the Geometry 
Menu, using the coordinate system aids for appropriate positioning of 
the shapes on the SIDE and the FACE. 

 
STEP 2.  Create Work Steps and set Machining Parameters 

Define Work Steps for each machining operation and apply the pa-
rameters as required by type of operation and tool that is used. If need-
ed, create and assign a path curve to each Work Step. Visualize the 
computed tool path to assure correct tool operation and proper setting 
of machining parameters. 

 
STEP 3.  Post G-Code 

Select the “Postprocessor” related to the type of control and let the 
software create the G-Code file. 

 
 
 
 

  

The EZ-Turn / TurnMill  Tutorial is set up in Metric with all Inputs 
and Dimensions in Millimeters ! 
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Picture 5-2 
 

Blueprint of EZ-TURN / TurnMill Tutorial 
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DEFINING ORIGIN, WINDOW SIZE AND LOCATION 
The window size is the distance from the edge of the window to the center of the win-
dow. The window location is the signed, absolute position of the window center from the 
part’s origin. The viewing parameters that are found in the Setup dialog box specify the 
size and location of the window. Note that you would not normally perform this step in 
programming a part, but it is necessary here to insure clarity in following the tutorial. 
Normally, you would just use the Zoom/Fade commands to set the window size as need-
ed. 
 
When selecting the origin for the part, choose a location that is referenced by the part’s 
dimensions. The origin should be selected before defining the window location (see next 
topic for setting up the workspace), because the window center is referenced from the 
part's origin. The graphic in Picture 5-3 below shows the location of the part origin for 
this exercise (X = -40 ; Y = 0). 
 
 
 

 
 

Picture 5-3 
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SETTING PREFERENCES 
Before continuing with the construction of the sample part, several parameters should be 
set so that the system is compatible with the instructions in this tutorial. Also the size of 
the workspace should be set. The sample part is about 100mm in the Z-axis and 100mm 
in the X-axis. Because of the size of the part, it is not convenient to work in the default 
window; therefore, the window and some default settings have to be changed. 
 
1. Select ”New” command from the “File” menu to restart EZ-CAM and clear the 

memory before continuing with the tutorial. Make sure that the “TURN” button is 
activated before pressing OK to start over. 

 

 
 
 

  
 

The “New” dialog is also used to switch between the EZ-Mill and 
EZ-Turn module. Before the dialog opens, the system checks the 
software protection key for activated modules. Modules or levels 
that are not activated will be marked by appended “DEMO” text. 
When working in “Demo” (evaluation) mode, it is not possible to 
print or save data. The corresponding “Save”,  “Save as” and 
“Print” commands are disabled. 
 
When closing the EZCAM application, the system automatically 
stores the last used level as default for the next session. 

 
 
2. Select ”Setup” command from the “View” menu 

 

3. Type “-40” for “X Center”, “0” for “Y Center” and “65” for “Size”. This sets the 
window size from the edge of the window to the center of the window, allowing 
enough room to see all of the part as it is created. See Picture 5-4. 
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4. Select “Metric” option button as the parts input dimension system. 

 

5. Click the “Background” list box and select “Black”. 

 

6. Select “Radius Input” option button as the parts X-axis input system. 

 

7. Disable “Planar Chain” option. 

 

8. Disable “Enable Y Coordinate Entry” option. 

 

9. Enable “Blank Verify”, “Show Curve Direction” and “Save as Default” options. 
Then close the dialog with OK button. 

 

 
 

Picture 5-4 
 
 
The initial setup for the EZ-TURN / TurnMill tutorial is now complete. Continue with the 
next section to create the geometry necessary for this part. 
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CREATING PART GEOMETRY (TURNING) 
Now that the workspace has been adjusted to accommodate the part, the creation of the 
part can begin. This involves creating geometry that is used to define the path curves for 
machining the part. The geometry is created first, so that the process of creating the 
curves is greatly simplified. 
 
First, we will define the basic geometry that defines the outside contour of the sample 
part. Then we continue with inserting the various fillets. At any time you may use the 
Undo/Redo buttons in the upper left corner to correct any mistakes you make. 
 
 
1. Select the “Connected Lines” command from the “Geometry” menu or click the cor-

responding button on the toolbar. 

Connected Lines 
 

2. EZ-TURN prompts you to pick the first point. Type “0” in the “Z” field of the Value 
Entry Box. Then press Tab to move the focus to the “X” input field. Type “0” for the 
X location and press the ENTER button to confirm the first point. 

 
 Z X 

P1 0 0 

 
3. Continue entering the Z and X values for points  #2 to #5 as listed in the table below. 

Press ENTER for each point to confirm the Z and X input. When finished the part 
geometry should appear as in Picture 5-5. 

 
 Z X 

P2   0 30 

P3 -35 30 

P4 -35 50 

P5 -100 50 
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Picture 5-5 
 
 

CREATING GEOMETRY FILLETS (TURNING) 
Follow the instructions below to create corner fillets for the main profile geometry of the 
sample part. 
 
1. Select the “Corner Fillet” command from the “Geometry” menu or click the corre-

sponding button on the toolbar. 

Corner Fillet 
 

2. Type “3” in the “R” field of the Value Entry Box to set the radius for the corner fil-
let. Then click the cursor at each position as shown in Picture 5-6. 

 
 

 
 
 

Picture 5-6 
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CREATING PATH CURVES (TURNING) 
EZ-Turn uses the curve entity to define a cutter path for each machining Work Step. 
Therefore we will now create the curves that are later used to define the path for the fac-
ing and outside turning operations before we continue to define geometry and curves for 
the turn-mill operations. The first curve will be used for facing while the second one rep-
resents the outside turning profile. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv1-Face” as the new ID and confirm with OK 
(Crv1 is the systems default ID and FACE is simply a description of the purpose of 
the curve). 

 
New 

 
2. Select the “Linear” command from the “Curves” menu or click  

Linear 
 
3.  The curve for this Work Step will consist of only one single linear move. To define 

the first point type “0” in the “Z” field of the Value Entry Box. Press Tab to move 
the focus to the “X” input field. Type “52.5” for the X location and press the ENTER 
button to confirm the first point. A small triangle is displayed on the screen. 

 
4.  For the second point type “0” for the X location (“Z” is already “0”) and press the 

ENTER button to confirm the second point. A blue line representing the new curve is 
now visible on the screen as seen in Picture 5-7 

 

 
 

Picture 5-7 
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Now, let's create the second curve that represents the outside turning profile. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv2-Turn” as the new ID and confirm with OK. 

 
New 

 
2. Select the “Chain” command from the “Curves” menu or click the corresponding 

button. 

Chain 
 
3. The prompt “Pick first line, arc, circle, or point figure” is displayed at the bottom 

edge of the window. Move the cursor to the position shown in Picture 5-8 and dou-
ble-click the mouse to select the line as the first element in the curve chain. The 
software automatically completes the curve by following the connected geometry el-
ements from the first point to the last. A small arrow referred to as the “direction in-
dicator” visualizes the curve direction. 

 
 

 
 

Picture 5-8 
 
 

   
In case path chaining failed for some reason (selected wrong ele-
ment or position), simply delete any already existing path elements 
by using the “Delete All Links” command from “Curves" menu.  
Then select “Chain” command and try again. 
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CREATING PART GEOMETRY (SIDE-POCKET) 
In the previous steps we created geometry and path curves for the regular turning opera-
tions. Next step will be doing the same for the pocket profile on the side of the part that 
will later be machined in a milling operation. All other turn-mill operations to machine 
the holes, small slots and the bolt-hole circle do not require any geometry or path curves 
since EZ-TURN provides machining cycles that include automatic pattern creation func-
tions.   
 
Before we continue with creating the geometry for the pocket we need to select the 
"SIDE" coordinate system in order to place the geometry correctly. 
 
1. Click the “Current UCS” button on the left bottom side of the window. 

Current UCS 
 

2. Click “SIDE” from the “Selection List Box” to change the coordinate system. 

 
 
3. Select “View X-Z” from the submenu “View Control” located in the “View” menu 

or press the corresponding button on the toolbar. 

View X-Z 
 
The steps 1-3 mentioned above are needed to prepare the working plane for SIDE geome-
try creation. Please check the “Current UCS” status before starting to draw the geometry. 
It should display  and the coordinate axes on the working plane 
should be X and Z. EZ-CAM window should now look like shown in Picture 5-9. What 
looks like a line in this picture is actually the previously created turning geometry as 
viewed from top. This is because the "SIDE" coordinate system is perpendicular to the 
"WORLD" coordinate system (see Picture 5-10). 
 
 

 
 
 

Picture 5-9 
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WORLD Plane

SIDE Plane Y

X

Z

 
 

Picture 5-10 
 
 
As we switched to the SIDE-working plane, there is no difference for applying any ge-
ometry to the current coordinate system. As you may have noticed at the Picture 5-10, 
the Z-axis for the SIDE plane coincides with the machine Z-axis. However, It is im-
portant to note that in EZ-TURN, geometry is always created on the XZ plane of the cur-
rent coordinate system no matter if it's later used for turning or milling operations. 
Movements defined on the X-axis of the SIDE coordinate system will later be interpreted 
as Y axis moves or wrapped profiles around Z axis (if no Y axis available). Coordinate 
and axis designator conversions are handled automatically by the system when posting 
the NC code. 
 
Let’s continue with the drawing of the rounded rectangle shape for the pocket boundary 
on the side of the part. 
 
 
1. Select the “Rectangle, Corner to Corner” command from the “Geometry” menu or 

click the corresponding button on the toolbar. 

Rectangle, Corner to Corner 
 

2. EZ-TURN prompts you to pick the first point. Type “-90” in the “Z” field of the 
Value Entry Box. Then press Tab to move the focus to the “X” input field. Type “-
20” for the X location and press the ENTER button to confirm the lower left corner 
point of the rectangle. 
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3. EZ-TURN prompts you to pick the second point. Type “-50” in the “Z” field of the 
Value Entry Box. Then press Tab to move the focus to the “X” input field. Type 
“20” for the X location and after another Tab keystroke input “5” for the radius value 
of the rectangle edges. Finally press the ENTER button to confirm the other corner 
location and edge roundness of the rectangle. 

 

 

 
 

Picture 5-11 
 
 
After creating the pocket boundary rectangle with round corners, the half circles at the 
two sides will be appended to the contour. This will be done by drawing circles centered 
at the middle points of the left and right side lines and trimming unnecessary segments 
from the shape afterwards. 
 
 
1. Select the “Circle/Arc, Center, Radius” command from the “Geometry” menu or 

click the corresponding button on the toolbar. 

Circle/Arc, Center, Radius 
 

2. The radius input field of the Value Entry Box becomes active and selected. Type “5” 
in the “R” field to designate the circle radius. 
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3. Turn on the “Midpoint” snap mode from the "Edit / Point Picking" menu or simply 
press the corresponding button on the toolbar. 

Midpoint 
 

4. EZ-TURN prompts you to pick the center point of the circle. Click the two points 
near the side lines of the rounded rectangle as shown in the Picture 5-12. This will 
draw two circles centered at the middle points of the rectangle sides. 

 

 

 
 
 

Picture 5-12 
 
 
 
Now, let’s trim the half of the circles and the line segments inside the circles to obtain the 
outer contour of the pocket. 
 
1. Select the “Remove to Closest” command from the "Geometry / Edit Line, Arc or 

Circle" menu or click the corresponding button on the toolbar. 

Remove to Clos-
est 

 

2. Click near the objects to be trimmed as shown in the Picture 5-13. Before clicking, 
check for the highlighted geometry sections (dashed lines in the picture) to verify 
removing the correct segment. 
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Picture 5-13 
 
 
After removing the unnecessary sections from the part’s side pocket profile, you will 
draw the connected lines to define the drilling locations in the pocket boundaries. The 
joints of the connected lines represent the center locations for the drilling operation. 
 
 
1. Select the “Connected Lines” command from the “Geometry” menu or click the cor-

responding button on the toolbar. 

Connected Lines 
 

2. Turn on the “Center Arc/Circle” snap function from the "Edit / Point Picking" menu 
or simply press the corresponding button on the toolbar. 

Center Arc/Circle 
 

3. Click the points defined in the Picture 5-14, sequentially from point #1 to point #4.  

 
 

 
 

Picture 5-14 
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CREATING PATH CURVES (SIDE POCKET) 
Now we will create two more path curves. The first defines the pocket boundary while 
the second one represents the center locations for the drilling operations, all on the side of 
the part. 
 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “Crv3-Pocket” as the new ID and confirm with OK 
(Crv3 is the systems default ID and POCKET is simply a description of the purpose 
of the curve). 

 
New 

 
 
2. Select the “Chain” command from the “Curves” menu or click the corresponding 

button. 

Chain 
 
 
3. The prompt “Pick first line, arc, circle, or point figure” is displayed at the bottom 

edge of the window. Move the cursor to the position shown in Picture 5-15 and dou-
ble-click the mouse. The software automatically completes the curve by following 
the connected geometry elements from the first point to the last. A small arrow re-
ferred to as the “direction indicator” visualizes the curve direction. 

 
 

 
 
 

Picture 5-15 
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Please note that, “Planar Chain” option in the “Setup” dialog box 
should be “unchecked” in order to successfully apply chain opera-
tion for the geometry elements when you are working on the SIDE 
coordinate plane. 

 
Now, let’s create the curve needed to represent the hole centers for the drilling operation 
on the side. 
 
1. Select the “New” command from the “Curves” menu or click the corresponding but-

ton. In the dialog that opens type “CrvSideDrill” as the new ID and confirm with 
OK. 

 
New 

 
2. Select the “Chain” command from the “Curves” menu or click the corresponding 

button. 

Chain 
 
3. The prompt “Pick first line, arc, circle, or point figure” is displayed at the bottom 

edge of the window. Move the cursor to the position shown in Picture 5-16 and dou-
ble-click the mouse to select the line as the first element in the curve chain. The 
software automatically completes the curve by following the connected geometry el-
ements from the first point to the last. A small arrow referred to as the “direction in-
dicator” visualizes the curve direction. 

 
 

 
 

Picture 5-16 
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CREATING THE PART PROGRAM 
Now as the geometry and some of the path curves (some feature-based Work Steps auto-
matically create needed curves, so we do not have to draw them) for the tutorial is com-
pleted, we continue with creation of the Work Steps necessary to machine the part. For 
this, select the desired cycle (Profile, Turn, Bore, etc.) for the regular turning operations 
or the feature to be applied for the milling / drilling operations. Then specify associated 
tool settings and machining parameters and define the path representing the cutting bor-
der (location for drilling). Finally verifying the calculated tool path assures correct tool 
operation. When all necessary Work Steps have been defined, the complete part program 
can again be verified for visual checks. If everything is ok continue to the next step and 
create the CNC-Code. 
 
 
The part program of the tutorial will consist of these 8 Work Steps: 
 
 
1. Face the front surface. 

2. Turn the exterior profile. 

3. Milling two pockets on the side of the part using Y -axis. 

4. Drilling four holes at the base of these two pockets. 

5. Milling three longitudinal side-slots equally spaced on the circumference. 

6. Drilling a hole at the center of each side-slot. 

7. Drilling 6 holes of the bolt-hole circle on the face of the part. 

8. Milling a rectangular slot on the front face. 

 
 
 

   
Execution of the Work Steps will be in the same order they have 
been created. You can use the integrated spreadsheet to perform 
operations such as moving, reordering or deleting existing Work 
Steps. 
 
See the “Spreadsheet” book in the online help for more detailed 
information. 

 
 
 



EZ-TURN / TURNMILL TUTORIAL 

EZ-CAM 5-19 

CREATING WORK STEP #1  (FACE TURNING) 
Now we create the first work step selecting a profile cycle that will make two passes on 
the face to make it an even surface. The two passes are defined by the "Total Stock" and 
"Depth" settings on the "Cycle Data" tab of the Work Step Data dialog.  
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 

 
 
2. Press the “New” button and input “Trn-Face” as the new Work Step ID and confirm 

with OK. 

 
 
3. Select “Profile” from the cycle list and “Crv1-Face” as the path curve. 

 
 
 
4. Now we select a tool. For this click the “Select Tool” button from the “Tool Info” 

tab to open the “Select Tool” dialog box. If there are no tools available select the 
“Change” button to load the “METTOOL.TLS” database from the “EZCAMW \ 
EZCAM..” directory. “EZCAM..” stands for the directory of the currently installed 
software release (\EZCAM14\.). This tool library includes the tools needed for the 
tutorial. 
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 Once the database is loaded highlight the tool ID “4-R08-80” (80 degree diamond 

insert, tip radius 0.8) and click the “Select” button as shown in Picture 5-17. 

 

 
 

Picture 5-17 
 
 
5. As we are already on the “Tool Info” tab, change the dialog settings as shown in the 

table below. See Picture 5-18 for the full dialog. 

 

Dialog Field Value Comment 

Number 1 
This number represents the tool position on the 
tool turret / magazine. 

Offset # 1 
Specifies the register number on the control were 
the current tool’s offset compensation values are 
stored. 

Z Index 125 Tool change position for Z axis 

X Index 125 Tool change position for X-axis 

Coolant FLOOD  
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Picture 5-18 
 



CHAPTER 5 

5-22 EZ-CAM 

 
6. Now select the “Cycle Data” tab and change settings according to the table below. 

Then close the dialog using the “Close” button. See Picture 5-19. 

 

Dialog Field Value Comment 

Offset Dir Left 
Defines the toolpath side as to the related 
curve and its direction. 

Z Fin Allow 0 
Finish allowance for the X / Z-axes. 

X Fin Allow 0 

Clear 2.5 
Clearance distance between material bounda-
ry and tool tip at the start of the cycle. 

Engage Angle 90 
Angle applied to engage move at the beginning 
of each roughing pass. 

Withdraw Angle 90 
Angle applied to retract move at the end of 
each roughing pass. 

Depth   1 Incremental depth increment for each pass. 

Total Stock 2 Total amount of stock to be machined. 

CSS Status ON 
When constant surface speed is set to ON, the 
machine tool automatically adjusts the RPM to 
maintain the specified CSS value. 

CSS Value 90 Sets constant surface speed (feed / minute). 

Max RPM 5000 Sets maximum spindle RPM if CSS ON. 

Feed Units UPR Sets Feed Rate type to Units Per Revolution. 

Feed Rate 0.25 Machining feed rate 

Outer Dia 105 Outside stock diameter 

Left Bound 0 Absolute Z position for left stock boundary 

Right Bound 2 Absolute Z position for right stock boundary 
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Picture 5-19 
 



CHAPTER 5 

5-24 EZ-CAM 

 
7. In order to correctly visualize the toolpath verification, first change the view. For 

this, press the “Current UCS” button on the left bottom side of the window. Click 
“World” from the “Selection List Box” to change the coordinate system. Select 
“View X-Z” from the submenu “View Control” located in the “View” menu or press 
the corresponding button on the toolbar. 
 

 

 Current UCS View X-Z 

 

8. Click the “Verify” button to calculate and display the tool path on the screen as 
shown in Picture 5-20. 

Verify 
 
 

 
 

Picture 5-20 
 
 

The Work Step #1 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #2  (OUTSIDE TURNING) 
The next step in creating the part program is to set up the turning cycle that turns down 
the exterior surfaces. 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 

 
2. Press the “New” button and input “Trn-OD-Rough” as the new Work Step ID and 

confirm with OK. 

 
 
3. Select “Turn” from the cycle list and “Crv2-Turn” as the path curve. 

 

 
 
4. Ensure that all parameters on the “Cycle Data” tab are set as listed in the table below. 

Other settings (also on “Tool Info” tab) are identical to the previous Work Step. 
Close the dialog using the “Close” button. See Picture 5-21 

 

Dialog Field Value Comment 

Z Fin Allow 0 
The “Fin Allow” settings specify separate finish 
allowance values for the X and Z axes 

X Fin Allow 0  

Clear 2.5 
Clearance distance between the material 
boundary and the tool tip at the start of the cy-
cle. 

Withdraw Angle 45 
Angle applied to retract move at the end of 
each roughing pass. 
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Withdraw Length 1.25 
Length of move when retracting at the end of 
each roughing pass. 

Depth   2 
Depth increment for each pass of roughing 
routine. 

Feed Rate 0.25 Feedrate rough passes 

Engage Feed 0.25 Feedrate depth moves 

Withdraw Feed 0.25 Feedrate retract moves 

Outer Dia 105 Outside stock diameter 

Left Bound -100 Absolute Z position for left stock boundary 

Right Bound 0 Absolute Z position for right stock boundary 
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Picture 5-21 
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5. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-22. 

Verify 
 
 

 
 

Picture 5-22 
 
 
 

The Work Step #2 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #3  (POCKET MILLING) 
This work step uses the "Turn Milling (Curves)" feature with it's "Pocket (Standard)" 
cycle to remove the material inside the defined boundary path curve. Finally the tool path 
will be copied 180 degree's to the opposite of the part using the parameters available on 
the "Copy & Indexing" dialog. 
 
 
1. Select the “New_Curve_Milling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Side-Pocket” as the new ID 
and confirm with OK. 

 
New Curve Milling 

 
 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-23. 

 

Dialog Field Value Comment 

Tool Number 2 Tool number on the tool turret / magazine. 

Offset # 2 Tool’s offset register number.  

Diameter 8 Diameter of the milling tool. 

Coolant FLOOD  

Spindle RPM 1200 Rotation speed of the milling tool. 

Feedrate (Z) 75 Plunge feedrate. 

Feedrate (XY) 150 Planar cutting feedrate. 

Surf (Zs) 50 
Radial position of the cutting path’s start-
ing point. 



CHAPTER 5 

5-30 EZ-CAM 

 

Rapid 2 

This parameter sets the main reference 
plane of the plunge axis as an absolute 
value from current MCS ("SIDE") . All oth-
er depth and rapid move settings (Rapid, 
Clear, Depth) are defined in relation to this 
plane. 

Clear 2 

This parameter sets the distance at which 
all rapid XY moves occur above the part. It 
is an unsigned incremental distance 
above the "Surf (Zs)"parameter. 

Depth (Zd) 10 

This parameter sets how far below the 
"Surf (Zs) parameter the tool will cut. The 
tool makes passes at the Step increment 
until it reaches the Depth level below the 
Surface level. 

Step 2 Depth of each cutting pass. 

Location Side Working plane that has the cutting path 
on. 

MSC ID SIDE 
Machining Coordinate System that is 
used. 

Cycle Pocket 
(Standard) 

Cutting Method that will be used for this 
step. 

Curve ID 
Crv3-
Pocket 

Path curve to be machined. 

Cut Step 4 Step-over distance. 

Y Axis Output ON 

Spindle will be locked and Y-axis will be 
used for movements. If unchecked, the 
tool path will be wrapped around the Z ax-
is 
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Picture 5-23 
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3. Click the “Copy & Indexing” button in the “TURN Milling (Curves)” window to 

open the “Side Copy & Indexing Options” dialog box and change the “Index Copy” 
settings according to the table below (see Picture 5-24). Confirm the settings by 
pressing “OK” button. After closing “Copy & Indexing” options, also confirm and 
close the “TURN Milling (Curves)” window by pressing its “OK” button. 

 

Dialog Field Value Comment 

Start Angle 0 Designates the radial start angle of the tool-
path. 

Increment Angle 180 Angle between each copied toolpath. 

Copies # 2 
Total number of toolpath copies that will be 
duplicated around the part. 

 
 
 

 
 

Picture 5-24 
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4. Click the “View Isometric” button and prepare an angular view. 

View Iso-
metric 

 
5. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-25. 

Verify 
 

 
 

Picture 5-25 
 
 
 

The Work Step #3 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #4  (SIDE DRILLING) 
The purpose of this work step is to drill the four holes at the bottom of the two pockets 
that were created previously. The tool path will again be copied 180 degree's for machin-
ing the holes in the second pocket. 
 
 
1. Select the “New_Curve_Drilling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Side-Drill1” as the new ID 
and confirm with OK. 

 
New Curve Drilling 

 
 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-26. 

 

Dialog Field Value Comment 

Tool Number 3 Tool number on the tool turret / magazine. 

Offset # 3 Tool’s offset register number.  

Diameter 5 Diameter of the drilling tool. 

Coolant FLOOD  

Spindle RPM 1200 Rotation speed of the drilling tool. 

Feedrate (Z) 75 Plunging speed of the drilling tool. 

Surf (Zs) 40 
Radial position of the cutting path’s start-
ing point. 

Rapid 12 
Rapid travel plane (10mm from previous 
pocket depth + 2mm rapid travel dis-
tance). 

Clear 2 
Distance to switch from rapid move to 
plunge feedrate. 

Depth (Zd) 6 Radial cutting depth. 

Step 2.5 Depth of each drilling plunge. 

Location Side Working plane that has the cutting path 
on. 
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MSC ID SIDE 
Machining Coordinate System that is 
used. 

Cycle Chip Break 
Drilling Method that will be used for this 
step. “Chip Break” drills the whole depth 
intermittently by the given step value. 

Curve ID CrvSideDrill Reference curve for toolpath calculation. 

Y Axis Output ON 
Spindle will be locked and Y-axis will be 
used for movements. 

 
 
 

 
 

Picture 5-26 
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3. Click the “Copy & Indexing” button in the “TURN Drilling (Curves)” window to 

open the “Side Copy & Indexing Options” dialog box and change the “Index Copy” 
settings according to the table below (see Picture 5-27). Confirm the settings by 
pressing “OK” button. After closing “Copy & Indexing” options, also confirm and 
close the “TURN Drilling (Curves)” window by pressing its “OK” button. 

 

Dialog Field Value Comment 

Start Angle 0 Designates the radial starting angle of the 
toolpath. 

Increment Angle 180 Angle between each copied toolpath. 

Copies # 2 
Total number of toolpath copies that will be 
duplicated around the part. 

 
 

 
 

Picture 5-27 
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4. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-28. 

  
 Verify 

 

 
 

Picture 5-28 
 
 
 

The Work Step #4 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #5  (SIDE SLOTTING) 
Now we will use the "Custom Shapes Milling" feature that eases machining by eliminat-
ing the need to create path curves as it provides a predefined set of shapes. Therefore we 
only need to define the shape specific dimensions and the location on the currently se-
lected MCS plane to machine the 3 slots that are equally spaced around the smaller diam-
eter section of the part. 
 
 
1. Select the “New_Shape_Milling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Side-Slot” as the new ID and 
confirm with OK. 

 
New Shape Milling 

 
 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-29. 

 

Dialog Field Value Comment 

Tool Number 4 Tool number on the tool turret / magazine. 

Offset # 4 Tool’s offset register number.  

Diameter 6 Diameter of the milling tool. 

Coolant FLOOD  

Spindle RPM 1200 Rotation speed of the milling tool. 

Feedrate (Z) 75 Plunging speed of the milling tool. 

Feedrate (XY) 120 
Planar moving speed of the tool while cut-
ting. 

Surf (Zs) 30 
Radial position of the cutting path’s starting 
point. 



EZ-TURN / TURNMILL TUTORIAL 

EZ-CAM 5-39 

 

Rapid 2 

This parameter sets the main reference 
plane of the plunge axis as an absolute val-
ue from current MCS ("SIDE") . All other 
depth and rapid move settings (Rapid, 
Clear, Depth) are defined in relation to this 
plane. 

Clear 2 

This parameter sets the distance at which 
all rapid XY moves occur above the part. It 
is an unsigned incremental distance above 
the "Surf (Zs)"parameter. 

Depth (Zd) 3 Radial cutting depth. 

Step 1 Incremental depth of each cutting pass. 

Location Side Working plane that has the cutting path on. 

MSC ID SIDE Machining Coordinate System that is used. 

Y Axis Output OFF Y-axis mode is deactivated. 

Shape Slot 
Pre-defined shape that will be used for 
toolpath creation. 

Center X (Cx) 0 
Arc length between the first slot’s position 
to the part’s reference point. 

Center Z (Cz) -17.5 
Distance of the slot center to the part’s ref-
erence position. 

Length (L) 10 Length of the tool move that creates the 
slot. 
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Picture 5-29 
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3. Click the “Copy & Indexing” button in the “TURN Milling (Custom Shapes)” win-

dow to open the “Side Copy & Indexing Options” dialog box and change the “Index 
Copy” settings according to the table below (see Picture 5-30). Confirm the settings 
by pressing “OK” button. After closing “Copy & Indexing” options, also confirm 
and close the “TURN Milling (Custom Shapes)” window by pressing its “OK” but-
ton. 

 

Dialog Field Value Comment 

Start Angle 0 
Designates the radial starting angle of the 
toolpath. 

Increment Angle 120 Angle between each copied toolpath. 

Copies # 3 
Total number of toolpath copies that will be 
duplicated around the part. 

 
 

 
 

Picture 5-30 
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4. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-31. 

  
 Verify 

 

 
 

Picture 5-31 
 
 
 

The Work Step #5 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #6  (SIDE - PATTERN DRILLING) 
This step uses the special "Pattern - Drilling" feature to machine the 3 holes that are lo-
cated in the center of the previously created slots. The hole locations are defined by se-
lecting a certain pattern with it's associated settings. This again eliminates the need to 
define any kind of path curve manually. 
 
 
1. Select the “New_Pattern_Drilling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Side-Drill2” as the new ID 
and confirm with OK. 

 
New Pattern Drilling 

 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-32. 

 

Dialog Field Value Comment 

Tool Number 5 Tool number on the tool turret / magazine. 

Offset # 5 Tool’s offset register number.  

Diameter 4 Diameter of the drilling tool. 

Coolant FLOOD  

Spindle RPM 1400 Rotation speed of the drilling tool. 

Feedrate (Z) 80 Plunging speed of the drilling tool. 

Surf (Zs) 27 
Radial position of the cutting path’s starting 
point. 

Rapid 5 
Rapid travel plane (3mm from previous slot 
depth + 2mm rapid travel distance). 

Clear 2 
Distance to the starting point, in which rap-
id vertical tool move is not allowed. 

Depth (Zd) 5 
Distance to switch from rapid move to 
plunge feedrate. 

Step 1.5 Depth of  each drilling plunge. 

Location Side Working plane that has the cutting path on. 
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MSC ID SIDE Machining Coordinate System that is used. 

Cycle 
Chip 
Break 

Drilling Method that will be used for this 
step. “Chip Break” drills the whole depth 
intermittently by the given step value. 

Y Axis Output OFF Y-axis mode is deactivated. 

Retract to Z 
Rapid 

ON 
Performs a movement that retracts the tool 
to the rapid plane. 

Pattern Rectangle Pattern that defines the hole positions. 

Start X (Sx) 0 
Arc length between the first hole’s position 
to the part’s reference point. 

Start Z (Sz) -17.5 
Distance between the hole center and the 
part’s reference position on Z-axis. 

X Spacing (Dx) 0 Arc length between each row of holes. 

Z Spacing (Dz) 0 Distance between each column on Z-axis. 

# Rows 1 Number of hole rows around the part. 

# Columns 1 Number of hole columns on Z-axis. 
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Picture 5-32 
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3. Click the “Copy & Indexing” button in the “TURN Drilling (Pattern)” window to 

open the “Side Copy & Indexing Options” dialog box and change the “Index Copy” 
settings according to the table below (see Picture 5-33). Confirm the settings by 
pressing “OK” button. After closing “Copy & Indexing” options, also confirm and 
close the “TURN Drilling (Pattern)” window by pressing its “OK” button. 

 

Dialog Field Value Comment 

Start Angle 0 Designates the radial starting angle of the 
toolpath. 

Increment Angle 120 Angle between each copied toolpath. 

Copies # 3 
Total number of toolpath copies that will be 
duplicated around the part. 

 
 

 
 

Picture 5-33 
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4. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-34. 

  
 Verify 

 

 
 

Picture 5-34 
 
 
 

The Work Step #6 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #7  (FACE - PATTERN DRILLING) 
As in the previous work step we will again use the "Pattern Drilling" feature to machine 
the 6 holes of the bolt-hole circle on the face. 
 
 
1. Select the “New_Pattern_Drilling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Face-Drill” as the new ID 
and confirm with OK. 

 
New Pattern Drilling 

 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-35. 

 

Dialog Field Value Comment 

Tool Number 6 Tool number on the tool turret / magazine. 

Offset # 6 Tool’s offset register number.  

Diameter 8 Diameter of the drilling tool. 

Coolant FLOOD  

Spindle RPM 1500 Rotation speed of the drilling tool. 

Feedrate (Z) 75 Plunging speed of the drilling tool. 

Surf (Zs) -35 Z-axis position of the face to be drilled. 

Rapid 37 
Distance to the drilling face, in which rapid 
moves on the same plane are not allowed. 

Clear 2 
Distance to the starting point, in which ver-
tical rapid tool move is not allowed. 

Depth (Zd) 5 
This parameter sets how far below the 
"Surf (Zs) parameter the tool will cut. 

Location Face-Left Working plane that has the cutting path on. 

MSC ID FACE Machining Coordinate System that is used. 

Cycle Drill 
Cutting method that will be used for this 
step. 

Pattern Circle Pattern that defines the hole positions. 
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Center X (Cx) 0 X-axis location of the pattern circle center. 

Z Center (Cz) 0 Z-axis location of the pattern circle center. 

# Holes 6 Number of holes that will be placed around 
the pattern circle with equal spacing. 

Radius 40 Radius of the pattern circle. 

Start Angle 0 
Angle of the first hole location according to 
the part’s reference. 

 
 

 
 

Picture 5-35 
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3. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-36. 

  
 Verify 

 

 
 
 

Picture 5-36 
 
 
 

The Work Step #7 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP #8  (FACE SLOTTING) 
The last work step will machine the slot on the face of the part by using the "Shape Mill-
ing" feature. 
 
 
1. Select the “New_Shape_Milling” command from the “Automation” menu or click 

the corresponding button. In the dialog that opens type “Face-Slot” as the new ID 
and confirm with OK. 

 

 
New Shape Milling 

 
2. Ensure that all parameters on the dialog are set as listed in the table below. When 

finished, the dialog should be displayed as shown in Picture 5-37. 

 

Dialog Field Value Comment 

Tool Number 7 Tool number on the tool turret / magazine. 

Offset # 7 Tool’s offset register number.  

Diameter 10 Diameter of the milling tool. 

Coolant FLOOD  

Spindle RPM 1200 Rotation speed of the milling tool. 

Feedrate (Z) 75 Plunging speed of the milling tool. 

Feedrate (XY) 120 
Planar moving speed of the tool while cut-
ting. 

Surf (Zs) 0 
Z-axis position of the face – Machining 
starting point. 

Rapid 2 
Distance to the machining face, in which 
rapid moves on the same plane are not 
allowed. 

Clear 2 Distance to the starting point, in which rap-
id vertical tool move is not allowed. 

Depth (Zd) 5 Cutting depth. 

Step 1.5 Depth of each cutting pass. 
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Location Face-Left 
Working plane that has the cutting path 
on. 

MSC ID FACE 
Machining Coordinate System that is 
used. 

Cycle 
Pocket 
(Standard) 

Cutting Method that will be used for this 
step. 

Cut Step 2 Distance between each pocket loop. 

Y Axis Output OFF Y-axis mode is deactivated. 

Shape Rectangle 
Pre-defined shape that will be used for 
toolpath creation. 

Center X (Cx) 0 X-axis position of the rectangle center. 

Center Z (Cz) 0 Z-axis position of the rectangle center. 

Length (L) 68 Length of the rectangle on Z-axis. 

Height (H) 15 Height of the rectangle on X-axis. 

Radius 0 Corner radius of the rectangle. 

 



EZ-TURN / TURNMILL TUTORIAL 

EZ-CAM 5-53 

 
 

 
 

Picture 5-37 
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3. Click the “Verify” button to calculate and display the tool path on the screen as 

shown in Picture 5-38. 

  
 Verify 

 

 
 

Picture 5-38 
 
 
 

The Work Step #8 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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VERIFYING ALL TOOL PATHS 
In this tutorial, you have verified the tool path of each Work Step individually. The “Ver-
ify All” command in the “Post” menu is used to estimate the total time it will take to ma-
chine the part. It automatically performs an on-screen verification of all of the part pro-
gram Work Steps in memory, in the machining order. The total machining time (exclud-
ing rapid traverse or tool change time) is displayed in a dialog box at the end of the veri-
fication process. 

 
Verify All 
 
 

 
 

Picture 5-39 
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3D SOLID PREVIEW 
One of the most powerful EZ-CAM features is the “3D Solid Preview” function. This 
function shows an animated tool cutting a solid model of the programmed part. The stock 
size is automatically calculated according to the calculated tool movements. Once the 
simulation is finished or interrupted by the user pressing “Esc” key, all dynamic view 
commands to rotate, zoom or move the simulated model on the screen are available. 
 
 
1. Select the “Preview 3D” command from the “Machining” menu or the corresponding 

button. See Picture 5-40.  

Preview 3D 
 

 
 

Picture 5-40 
 
 
2. Once the simulation stopped you can change the on-screen view by using the dynam-

ic view commands (Rotate, Pan, Zoom) under the “View / Dynamic Viewing” menu. 

Dynamic Rotate Dynamic Zoom Dynamic Pan
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SAVING THE PART 
It is very important to save the newly created or edited part from memory to disk periodi-
cally during a session as well as at the end to ensure that no information is lost. The EZ-
CAM “Save” and “Save As” commands under the “File” menu transfer files from system 
memory to a hard disk or other media. In EZ-TURN, the part information is stored in two 
different types of files, the “Part” file using the extension "TRN" and the associated “Ge-
ometry” file with extension "GEO". This flexibility allows the user to load an existing 
part file to be used with newly created geometry and path curves. 
 
File Type  : GEOMETRY 
Extension : GEO 
Data  : Geometry Elements (lines, arcs, etc.), Curves, 

  User-Coordinate Systems (UCS) 
 
File Type  : PART Files 
Extension : TRN 
Data     : Work Step Data (Technology & Machining Information) 
 
There is no specific rule what should be saved first. Of course, if there is only one kind of 
data in memory (Work Steps or Geometry) the “Save As” dialog will automatically open 
with the correct file type. 
 
 

 
 

Picture 5-41 
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1. Select “Save As” command from the “File” menu. 

 

2. Select the appropriate drive and folder where the geometry and part files should be 
stored. You can use the “EZCAMW \ TURNPARTS” folder that was automatically 
created by the setup routine. 

 

3. Select “Geometry (*.GEO)” from the “Save as type” list box to store the geometry 
data. 

 

4. Type the new filename “Turn-Mill Tutorial” in the File Name box and click the 
“Save” button. The file extension is added automatically.  

 

5. To store the machining information (Work Step Data) select “Part Files (*.TRN)” 
from the “Save as type” list box and click “Save” again. 

 
 

   
If you have already saved the geometry, the software automatically 
inserts a part file with the same name but different extension 
(*.TRN) in the “Save” menu when the first Work Step is created. 
All you have to do is to select “Save All” option from the “File” 
menu or the corresponding toolbar button. 

 
Save 
All 

 

 
 
 
 
 
 
The software will save and overwrite the existing files without any 
screen prompt. You can use this command anytime for fast saving 
of your work. 
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It is not possible to save data when the software is running in 
evaluation mode. The “Save”, “Save as” and “Print” commands 
are disabled. 

 

CREATING CNC CODE 
Now that the part program has been created, it must be converted to run on a NC control 
by running the “Post” command with the appropriate “Post-Processor” for your machine. 
 

   
 

The CNC data file or “Post-Processor” is used as a "template" to 
format the part program data file that was created in EZ-Turn. 
This template consists of program formats (e.g., TOOL 
CHANGE, LINEAR MOVE, etc.) that determine the structure of 
a part program for a specific CNC. To create or edit a “Post-
Processor” a special editor called “TBuild” is required.  

 
1. Select “Post” command in the “Machining” menu to open the “Post Process” dialog. 

 

 
 

Picture 5-42 
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2. First you need to select the postprocessor. If the one desired is already loaded and 

displayed in the section “CNC-File”, continue to the next step. Otherwise use the 
“Change” button to browse your system for a different one. For this tutorial you may 
use the “FAN-18T.CNC” post (standard metric post that creates Fanuc style code). 

 

   
 

Standard postprocessor folders created by the EZ-CAM v15 setup: 
 
INCH 
<DRIVE>: \ EZCAMW \ EZCAM15 \TURNINCHPOST 
 
METRIC 
<DRIVE>: \ EZCAMW \ EZCAM15 \TURNMETRICPOST 

 
3. Select the “G-Code” option from the “Listings” list box. The computed program text 

will be displayed on the screen. 

 

4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” 
application when posting of the part file is finished and load the newly created file 
for sending it top the machine using the serial port. 

 

5. Next is the “G-Code File” section. Here the default name and directory for the com-
puted program file is displayed. The name is taken from the part file that was saved 
before. The default directory is “EZCAMW\TURNGCODE”. 

 
 

   
 

Ensure that part file and postprocessor share the same dimension 
unit (“Metric” for this tutorial). The system will generate a “Di-
mension Unit Conflict” message, but then automatically scale the 
NC-Code according to the dimension specified in the postproces-
sor.  
  
See online help for more information about the “Setup” dialog 
located in the “View” menu. 
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6. Click the “Post” to start posting. The Processing window will be displayed showing 
messages followed by listings of ASCII code created. When all Work Steps have 
been processed, a final message box is displayed as shown in Picture 5-40. 

 
 

 
 

Picture 5-43 
 
 
 
7. Click OK to close the message dialog box. To close the Processing window 

click  at the top right-hand corner of the window. 

 
 
 

Congratulations! 
 

You've completed the EZ-Turn & Live-Tool Operations Tutorial ! 
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COMMUNICATION WITH THE CONTROL 
When the part program is posted with the “EZ-DNC” option checked, “EZ-DNC” appli-
cation starts and automatically loads the newly created file as shown in Picture 6-1. “EZ-
DNC” is a light version of the EZCAM “Filtermax” application and limited to editing and 
serial (RS232) communication functionality. Next step would be to load the correct 
communication settings (Port, Baudrate, Handshake, etc.) for the control and starting the 
file transfer. See EZ-DNC online help for more information. 
 
 
 

 
 

Picture 6-1 
 

CHAPTER 6.  
COMMUNICATION WITH THE CONTROL 
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1. Open the “RS232 Settings” dialog through the “DNC” menu to check the serial port 

related communication settings. Close the dialog using OK button. 

 

 
 

Picture 6-2 
 

   
The system automatically saves all current settings as defaults for 
future sessions. 
You can also use the “Save Settings” and “Load Settings” com-
mands from the “File” menu to work with settings for different 
types of controls. 
 
The EZ-CAM setup has already copied setting files (*.PAR) for 
most common controls into the “\EZCAMW\FilterMAX\ParFiles” 
folder. 
 
“FilterMAX..” stands for the directory of the currently installed 
software release (FilterMAX6 , FilterMAX7, etc.) 
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2. Open the “DNC Settings” dialog through the “DNC” menu to check special character 

settings and filters. See Picture 6-3.  

 
 

 
 

Picture 6-3 
 
 
3. Start to send the NC file in the editor by selecting the “Send Text” command from 

the “DNC” menu. 

 
 

    
Depending on the type of control you may start the controls “Re-
ceive” function before selecting the “Send text” command. 
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CABLE DIAGRAMS 
In order for the EZ-CAM computer to send a part program to the control it must be con-
nected to the machine with a cable. The wiring layout strongly depends on the communi-
cation software, the type of control and selected handshake mode (XON/XOFF or 
RTS/CTS). There may be additional considerations such as the usage of existing wiring 
that might limit communication functionality. The graphics shown below represent con-
nection diagrams that will work with some of the most common controls (Fanuc, Hei-
denhain, etc.). The last diagram (“Universal”) also handles the DSR, DCD and DTR sig-
nals required by some controls. 
 
 

CABLE LAYOUT 1: 
XON /XOFF SOFTWARE HANDSHAKE (FANUC) 
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COMMUNICATION WITH THE CONTROL 

EZ-CAM 6-5 

CABLE LAYOUT 2: 
RTS /CTS HARDWARE HANDSHAKE (HEIDENHAIN) 
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CHAPTER 6 

6-6 EZ-CAM 

CABLE LAYOUT 3: 
UNIVERSAL (XON/XOFF AND/OR RTS/CTS) 
 
 

Computer 
25 Pin Serial Port 

Machine 
25 Pin Serial Port 

 

6

8

20

2

3

4

5

7GND

DCD

DTR

TxD

RxD

RTS

CTS

DSR

GND

DCD

DTR

TxD

RxD

RTS

CTS

DSR6

8

20

2

3

4

5

7

 
 
 

Computer 
9 Pin Serial Port 

Machine 
25 Pin Serial Port 

 

6

1

4

2

3

7

8

5GND

DCD

DTR

RxD

TxD

RTS

CTS

DSR

GND

DCD

DTR

TxD

RxD

RTS

CTS

DSR6

8

20

2

3

4

5

7

 
 
 

    
In case of trouble you may also consult the control’s documenta-
tion or contact the machine tool dealer for more information about 
parameter settings and file transfer procedures. 
 
You may also consult the “EZ-DNC” online help for more infor-
mation. 
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